
PilzDrive Based Center Winder – PMC
SC6, PMC SI6

Manual-1006912-en-US-02



Table of contents

Manual Drive Based Center Winder – PMC SC6, PMC SI6
1006912-en-US-02

Pilz | 2

Table of contents

Table of contents ............................................................................................................................................ 2

1 Foreword.......................................................................................................................................................... 5

2 User information ............................................................................................................................................. 6
2.1 Storage and transfer ......................................................................................................................................... 6
2.2 Described product ............................................................................................................................................. 6
2.3 Directives and standards................................................................................................................................... 6
2.4 Timeliness ......................................................................................................................................................... 6
2.5 Original language .............................................................................................................................................. 6
2.6 Limitation of liability ........................................................................................................................................... 6
2.7 Formatting conventions..................................................................................................................................... 7
2.7.1 Display of warning messages and information.................................................................................................. 7
2.7.2 Markup of text elements.................................................................................................................................... 8
2.7.3 Mathematics and formulas ................................................................................................................................ 8
2.8 Trademarks ....................................................................................................................................................... 9

3 Safety notes................................................................................................................................................... 10

4 What you should know before commissioning.......................................................................................... 11
4.1 DS6 program interface .................................................................................................................................... 11
4.1.1 Configuring the view........................................................................................................................................ 13
4.1.2 Navigation using sensitive circuit diagrams .................................................................................................... 14
4.2 Meaning of parameters ................................................................................................................................... 15
4.2.1 Parameter groups ........................................................................................................................................... 15
4.2.2 Parameter types and data types ..................................................................................................................... 16
4.2.3 Parameter types.............................................................................................................................................. 17
4.2.4 Parameter structure ........................................................................................................................................ 17
4.2.5 Parameter visibility .......................................................................................................................................... 18
4.3 Signal sources and process data mapping ..................................................................................................... 19
4.4 Non-volatile memory ....................................................................................................................................... 20

5 Commissioning ............................................................................................................................................. 21
5.1 Initiating the project ......................................................................................................................................... 22
5.1.1 Projecting the drive controller and axis ........................................................................................................... 22
5.1.2 Configuring safety technology......................................................................................................................... 23
5.1.3 Creating other drive controllers and modules ................................................................................................. 24
5.1.4 Projecting the module ..................................................................................................................................... 24
5.1.5 Projecting the project ...................................................................................................................................... 25
5.2 Mapping the mechanical axis model ............................................................................................................... 26
5.2.1 Parameterizing the motor................................................................................................................................ 26
5.2.2 Parameterizing the axis model........................................................................................................................ 27
5.2.2.1 Define the axis model...................................................................................................................................... 28
5.2.2.2 Scale the axis.................................................................................................................................................. 29
5.2.2.3 Parameterizing the position and velocity window............................................................................................ 30
5.2.2.4 Limiting the axis .............................................................................................................................................. 30
5.3 Referencing absolute position......................................................................................................................... 32
5.3.1 Defining the referencing method ..................................................................................................................... 32
5.3.2 Parameterizing the reference switch............................................................................................................... 32
5.3.3 Setting the reference....................................................................................................................................... 33
5.3.4 Parameterizing the limit switch........................................................................................................................ 33



Table of contents

Manual Drive Based Center Winder – PMC SC6, PMC SI6
1006912-en-US-02

Pilz | 3

5.4 Parameterizing Drive Based device control .................................................................................................... 34
5.4.1 Parameterizing transition conditions ............................................................................................................... 34
5.5 Transmitting and saving the configuration ...................................................................................................... 35
5.6 Testing the configuration................................................................................................................................. 37
5.6.1 Testing jog mode............................................................................................................................................. 37
5.6.2 Testing the motion commands ........................................................................................................................ 39
5.7 Parameterizing the Drive Based Center Winder application ........................................................................... 41
5.7.1 General motion variables and signal sources ................................................................................................. 41
5.7.1.1 Velocity – Parameterizing sources.................................................................................................................. 42
5.7.1.2 Velocity override – Parameterizing the source................................................................................................ 43
5.7.1.3 Torque/Force – Parameterizing sources......................................................................................................... 43
5.7.2 Parameterizing center winder operating mode ............................................................................................... 45
5.7.2.1 Activating center winder operating mode ........................................................................................................ 46
5.7.2.2 Parameterizing the diameter source ............................................................................................................... 46
5.7.2.3 Compensating for friction and mass inertia..................................................................................................... 50
5.7.2.4 Parameterizing the set material velocity ......................................................................................................... 56
5.7.2.5 Parameterizing the actual material velocity..................................................................................................... 57
5.7.2.6 Parameterizing the set material tensile force .................................................................................................. 58
5.7.3 Parameterizing command operating mode ..................................................................................................... 59
5.7.3.1 Activating command operating mode.............................................................................................................. 60
5.7.3.2 Parameterizing the center winder ................................................................................................................... 61
5.7.3.3 Limiting the torque/force using the operating mode ........................................................................................ 74
5.7.3.4 Parameterizing command-specific motion variables....................................................................................... 75
5.7.3.5 Parameterizing the start signal........................................................................................................................ 77
5.7.3.6 Parameterizing the continue signal ................................................................................................................. 77

6 More on Drive Based Center Winder?......................................................................................................... 78
6.1 Drive Based Center Winder – Concept ........................................................................................................... 78
6.1.1 Operating modes............................................................................................................................................. 79
6.1.1.1 Center winder.................................................................................................................................................. 80
6.1.1.2 Command........................................................................................................................................................ 80
6.1.2 Jog mode ........................................................................................................................................................ 80
6.1.3 Control panels ................................................................................................................................................. 81
6.1.4 Motion core ..................................................................................................................................................... 81
6.1.5 Data sources ................................................................................................................................................... 81
6.1.6 Additional functions ......................................................................................................................................... 82
6.1.6.1 Additional counter function.............................................................................................................................. 82
6.1.6.2 Additional motor potentiometer function.......................................................................................................... 85
6.2 Center winder – Concept ................................................................................................................................ 92
6.2.1 Compensation for friction and mass inertia..................................................................................................... 94
6.3 Axis model....................................................................................................................................................... 95
6.4 Limit switches.................................................................................................................................................. 98
6.4.1 Real axes ........................................................................................................................................................ 98
6.4.1.1 Faults .............................................................................................................................................................. 98
6.4.1.2 Denial .............................................................................................................................................................. 99
6.4.1.3 Hardware limit switches ................................................................................................................................ 100
6.4.1.4 Hardware limit switches when referencing.................................................................................................... 101
6.4.1.5 Software limit switches.................................................................................................................................. 102
6.4.1.6 Software limit switches when referencing ..................................................................................................... 102
6.4.1.7 Shutting down by the limit switch .................................................................................................................. 102
6.4.2 Special cases ................................................................................................................................................ 103
6.4.2.1 Behavior in jog mode .................................................................................................................................... 103
6.4.2.2 Reaching the +/- 31 bit computing limit ......................................................................................................... 103



Table of contents

Manual Drive Based Center Winder – PMC SC6, PMC SI6
1006912-en-US-02

Pilz | 4

6.4.2.3 Linear motor travel range .............................................................................................................................. 103
6.4.2.4 Simultaneous detection of positive and negative hardware limit switches.................................................... 104
6.4.2.5 Behavior upon controller start-up .................................................................................................................. 104
6.5 Referencing................................................................................................................................................... 104
6.5.1 Referencing methods .................................................................................................................................... 105
6.5.1.1 Referencing methods in detail....................................................................................................................... 106
6.5.2 Reference position ........................................................................................................................................ 132
6.5.3 Reference retaining....................................................................................................................................... 132
6.6 Drive Based device control ........................................................................................................................... 133
6.6.1 Drive Based device state machine................................................................................................................ 134
6.6.2 States, transitions and conditions ................................................................................................................. 134
6.6.2.1 Not ready to switch on................................................................................................................................... 134
6.6.2.2 Switch on disabled ........................................................................................................................................ 135
6.6.2.3 Ready to switch on........................................................................................................................................ 135
6.6.2.4 Switched on................................................................................................................................................... 136
6.6.2.5 Operation enabled......................................................................................................................................... 136
6.6.2.6 Quick stop active........................................................................................................................................... 137
6.6.2.7 Fault reaction active ...................................................................................................................................... 137
6.6.2.8 Fault .............................................................................................................................................................. 138
6.7 Motion commands......................................................................................................................................... 139
6.8 Continue function .......................................................................................................................................... 141
6.9 Electronic nameplate..................................................................................................................................... 142
6.10 Lag monitoring .............................................................................................................................................. 142

7 Appendix...................................................................................................................................................... 143
7.1 Standard mapping of Drive Based Center Winder ........................................................................................ 143
7.1.1 PMC SC6, PMC SI6: Drive Based Center Winder receive process data...................................................... 144
7.1.2 PMC SC6, PMC SI6: Drive Based Center Winder transmit process data..................................................... 145
7.2 Further information........................................................................................................................................ 146
7.3 Formula symbols........................................................................................................................................... 147
7.4 Abbreviations ................................................................................................................................................ 148

List of figures .............................................................................................................................................. 149

List of tables ................................................................................................................................................ 150

Glossary....................................................................................................................................................... 151



Foreword

Manual Drive Based Center Winder – PMC SC6, PMC SI6
1006912-en-US-02

Pilz | 5

1 Foreword
This documentation describes the general functions of the Drive Based Center Winder application
and guides you step by step through the setup and project configuration of your drive project in the
individual operating modes.

The Drive Based Center Winder application contained in the software provides universal solutions for
drive-based motion control using position, velocity and torque/force control types. The motion
commands associated with these control types are categorized into the following operating modes:

} Command

} Center winder

The Drive Based Center Winder application enables you to realize various winding applications for
the center winder, e.g. winding, unwinding or rewinding materials such as plastic, wire, textiles or
paper, via tensile force control and with the help of the 30: MC_Winder motion command.

Additional functions for monitoring process variables such as positions or velocities offer added
convenience in monitoring.

The DriveControlSuite commissioning software for 6th generation drive controllers offers convenient
functions for efficient project configuration and commissioning of drive controllers in multi-axis and
single-axis applications.
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2 User information
This documentation supports you in the setup and project configuration of your drive system with the
Drive Based Center Winder application in conjunction with Drive Based device control.

Technical knowledge
To be able to commission one or more drive controllers using the Drive Based Center Winder
application, possibly in combination with a controller, you should have basic knowledge of handling
6th generation Pilz drive controllers and of the DriveControlSuite commissioning software.

Technical requirements
Before you begin operating your drive system, you need to have wired the drive controllers involved
and initially check that they are functioning correctly. To do this, follow the instructions in the manual
for the relevant drive controller.

2.1 Storage and transfer
As this documentation contains important information for handling the product safely and efficiently, it
must be stored in the immediate vicinity of the product until product disposal and be accessible to
qualified personnel at all times.

Also pass on this documentation if the product is transferred or sold to a third party.

2.2 Described product
This documentation is binding for:

PMC SC6 or PMC SI6 series drive controllers in conjunction with the DriveControlSuite software
(DS6) in V 6.5-L or later and associated firmware in V 6.5-L or later.

2.3 Directives and standards
Refer to the drive controller documentation for the European directives and standards relevant to the
drive controller and accessories.

2.4 Timeliness
Check whether this document is the most up-to-date version of the documentation. We make the
latest document versions for our products available for download on our website:
https://www.pilz.com/en-INT.

2.5 Original language
The original language of this documentation is German; all other language versions are derived from
the original language.

2.6 Limitation of liability
This documentation was created taking into account the applicable standards and regulations as well
as the current state of technology.

No warranty or liability claims for damage shall result from failure to comply with the documentation or
from use that deviates from the intended use of the product. This is especially true for damage
caused by individual technical modifications to the product or the project configuration and operation
of the product by unqualified personnel.

https://www.pilz.com/en-INT
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2.7 Formatting conventions
Orientation guides in the form of signal words, symbols and special text markups are used to
emphasize specific information so that you are able identify it in this documentation quickly.

2.7.1 Display of warning messages and information
Warning messages are identified with symbols. They indicate special risks when handling the product
and are accompanied by relevant signal words that express the extent of the risk. Furthermore, useful
tips and recommendations for efficient, error-free operation are specially highlighted.

ATTENTION!

Attention indicates that damage to property may occur

▪ if the stated precautionary measures are not taken.

CAUTION!

Caution with a warning triangle indicates that minor personal injury may occur

▪ if the stated precautionary measures are not taken.

WARNING!

Warning with a warning triangle means there may be a considerable risk of fatal
injury

▪ if the stated precautionary measures are not taken.

DANGER!

Danger with a warning triangle indicates that there is a considerable risk of fatal
injury

▪ if the stated precautionary measures are not taken.

Information

Information indicates important information about the product or serves to
emphasize a section in the documentation that deserves special attention from the
reader.
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2.7.2 Markup of text elements
Certain elements of the continuous text are distinguished as follows.

Important information Words or expressions with a special meaning

Interpolated position mode Optional: File or product name or other name

Detailed information Internal cross-reference

http://www.samplelink.com External cross-reference

Software and other displays
The following formatting is used to identify the various information content of elements referenced by
the software interface or a drive controller display, as well as any user entries.

Main menu 
Settings

Window names, dialog box names, page names or
buttons, combined proper nouns, functions referenced by
the interface

Select 
Referencing method A

Predefined entry

Save your 
<own IP address>

User-defined entry

EVENT 52: 
COMMUNICATION

Displays (status, messages, warnings, faults)

Keyboard shortcuts and command sequences or paths are represented as follows.

[CTRL], [CTRL] + [S] Key, key combination

Table > Insert table Navigation to menus/submenus (path specification)

2.7.3 Mathematics and formulas
The following signs are used to represent mathematical relationships and formulas.

– Subtraction
+ Addition
× Multiplication
÷ Division
| | Absolute value

http://www.stoeber.de
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2.8 Trademarks
The following names used in connection with the device, its optional equipment and its accessories
are trademarks or registered trademarks of other companies:

CANopen®, 
CiA®

CANopen® and CiA® are registered European Union trademarks of
CAN in AUTOMATION e.V., Nuremberg, Germany.

EnDat® EnDat® and the EnDat® logo are registered trademarks of 
Dr. Johannes Heidenhain GmbH, Traunreut, Germany.

EtherCAT®,
Safety over EtherCAT®,
TwinCAT®

EtherCAT®, Safety over EtherCAT® and TwinCAT® are registered
trademarks of patented technologies licensed by Beckhoff
Automation GmbH, Verl, Germany.

PLCopen® PLCopen® is a registered trademark of the PLCopen Organisation,
Gorinchem, Netherlands.

PROFIBUS®, 
PROFINET®

PROFIBUS® and PROFINET® are registered trademarks of
PROFIBUS Nutzerorganisation e.V., Karlsruhe, Germany.

All other trademarks not listed here are the property of their respective owners.

Products that are registered as trademarks are not specially indicated in this documentation. Existing
property rights (patents, trademarks, protection of utility models) are to be observed.
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3 Safety notes

WARNING!

Risk of fatal injury if safety notes and residual risks are not observed!

Failure to observe the safety notes and residual risks in the drive controller
documentation may result in accidents causing serious injury or death.

▪ Observe the safety notes in the drive controller documentation.

▪ Consider the residual risks in the risk assessment for the machine or system.

WARNING!

Malfunction of the machine due to incorrect or modified parameterization!

In the event of incorrect or modified parameterization, malfunctions can occur on
machines or systems which can lead to serious injuries or death.

▪ Observe the security notes in the drive controller documentation.

▪ Protect the parameterization, e.g. from unauthorized access.

▪ Take appropriate measures for possible malfunctions (e.g. emergency off or
emergency stop).
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4 What you should know before commissioning
The following chapters provide a quick introduction to the structure of the program interface and
accompanying window designations as well as relevant information about parameters and generally
saving your project configuration.

4.1 DS6 program interface
Using the graphical interface of the DriveControlSuite commissioning software (DS6), you can project,
parameterize and commission your drive project quickly and efficiently. In case of service, you can
evaluate diagnostic information such as operating states, fault memories and fault counters of your
drive project using DriveControlSuite.

Information

The program interface of DriveControlSuite is available in German, English and
French. To change the language of the program interface, select Settings >
Language.

Information

The DriveControlSuite help in the menu bar can be reached via Help > Help for DS6
or via the [F1] key on your keyboard. When you press [F1] in an area of the program,
the corresponding help topic opens.
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Fig. 1: DS6: Program interface

No. Area Description

1 Menu bar Using the File, View, Settings and Window menus, you can open and
save projects, display and hide program windows, select the interface
language and access level and change between different windows in the
workspace.

2 Toolbar The toolbar enables quick access to frequently needed functions, like
opening and saving projects and hiding and displaying windows in the
program interface.

3 Project tree The project tree forms the structure of your drive project in the form of
modules and drive controllers. Select an element using the project tree
first in order to edit it using the project menu.

4 Project menu The project menu offers you various functions for editing the project,
module and drive controller. The project menu adapts to the element that
you selected in the project tree.

5 Workspace The different windows which can be used to edit your drive project, such
as the configuration dialog, wizards, the parameter list or the scope
analysis tool, open in the workspace.

6 Parameter check The parameter check points out irregularities and inconsistencies that
were detected in the plausibility check of calculable parameters.

7 Messages The entries in the messages log the connection and communication status
of the drive controllers, incorrect inputs caught by the system, errors when
opening a project or rule violations in the graphical programming.

8 Variable
parameter lists

You can use variable parameter lists to compile any parameters in
individual parameter lists for a quick overview.

9 Status bar In the status bar, you can find the specifications of the software version
and get additional information about the project file, the devices and the
progress of the process during processes such as loading projects.
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4.1.1 Configuring the view
In DriveControlSuite, you can change the visibility and arrangement of areas and windows, such as to
optimize the available space in the workspace when working with smaller screens.

Showing/hiding areas
Use the icons in the toolbar or the items in the View menu to show or hide specific areas in
DriveControlSuite as needed.

Icon Item Description

– Reset Resets the view to factory settings.

Project Shows/hides the Project window (project tree,
project menu).

Messages Shows/hides the Messages window.

Parameter check Shows/hides the Parameter check window.

Variable parameter
lists

Shows/hides the Variable parameter lists
window.

Arrange and group areas
You can undock and rearrange the individual areas via drag and drop. If you drag an undocked
window to the edge of DriveControlSuite, you can release it there in a color-highlighted area either
next to or on top of another window to redock it.

When you release the window onto another window, the two areas are merged into one window
where you can use tabs to switch between the areas.
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4.1.2 Navigation using sensitive circuit diagrams

Fig. 2: DriveControlSuite: Navigation using text links and symbols

In order to illustrate graphically the processing sequence of actual and set values, the use of signals
or certain drive component arrangements and to make configuring the accompanying parameters
easier, they are displayed on the respective wizard pages of the workspace in the form of circuit
diagrams.

Blue text links or clickable icons indicate links within the program. These refer to the corresponding
wizard pages and, as a result, allow you to reach additional helpful detail pages with just a click.
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4.2 Meaning of parameters
You can use parameters to adapt the function of the drive controller to your individual application. In
addition, parameters visualize the current actual values (actual velocity, actual torque, etc.) and
trigger actions such as Save values, Test phase, etc.

Interpretation of parameter identification
Parameter identification consists of the following elements, where short forms are also possible, i.e.
only specifying a coordinate or the combination of coordinate and name.

E50 V0

Coordinate Name Version

Drive controller G6

Drive controller
generation/series

4.2.1 Parameter groups
Parameters are assigned to individual groups by topic. The drive controllers differentiate between the
following parameter groups.

Group Topic

 A Drive controllers, communication, cycle times

B Motor

C Machine, velocity, torque/force, comparators

D Set value

E Display

F Terminals, analog and digital inputs and outputs, brake

G Technology – Part 1 (application-dependent)

H Encoder

I Motion (all motion settings)

J Motion blocks

K Control panel

L Technology – Part 2 (application-dependent)

M Profiles (application-dependent)

N Additional functions (application-dependent; e.g. extended cam control unit)

P Customer-specific parameters (programming)

Q Customer-specific parameters, instance-dependent (programming)

R Production data for the drive controller, motor, brakes, motor adapter, gear unit and
geared motor

S Safety (safety technology)

T Scope

U Protection functions

Z Fault counter

Tab. 1: Parameter groups
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4.2.2 Parameter types and data types
In addition to topic-based sorting in individual groups, all parameters belong to a certain data type and
parameter type. The data type of a parameter is displayed in the parameter list, properties table. The
connections between parameter types, data types and their value range can be found in the following
table.

Data type Parameter type Length Value range
(decimal)

INT8 Integer or selection 1 byte (signed) -128 – 127

INT16 Integer 2 bytes (1 word,
signed)

-32768 – 32767

INT32 Integer or position 4 bytes (1 double word,
signed)

-2 147 483 648 
– 2 147 483 647

BOOL Binary number 1 bit (internal: 
LSB in 1 byte)

0, 1

BYTE Binary number 1 byte (unsigned) 0 – 255

WORD Binary number 2 bytes (1 word,
unsigned)

0 – 65535

DWORD Binary number or
parameter address

4 bytes (1 double word,
unsigned)

0 – 4 294 967 295

REAL32
(single type according
to IEE754)

Floating-point number 4 bytes (1 double word,
signed)

-3.40282 × 1038 
– 3.40282 × 1038

STR8 Text 8 characters —

STR16 Text 16 characters —

STR80 Text 80 characters —

Tab. 2: Parameters: Data types, parameter types, possible values

Parameter types: Use
} Integer, floating-point number

For general computing processes
Example: Set and actual values

} Selection
Numeric value to which a direct meaning is assigned
Example: Sources for signals or set values

} Binary number
Bit-oriented parameter information that is collected in binary
Example: Control and status words

} Position
Integer combined with associated units and decimal places
Example: Actual and set values of positions

} Velocity, acceleration, deceleration, jerk
Floating-point number combined with associated units
Example: Actual and set values for velocity, acceleration, deceleration, jerk

} Parameter address
Referencing of a parameter
Example: In F40 AO1 source, for example, E08 n-motor filtered can be parameterized

} Text
Outputs or messages
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4.2.3 Parameter types
The following types of parameters are differentiated.

Parameter type Description Example

Simple parameters Consist of one group and one line
with a defined value.

A21 Brake resistor R: Value =
100 ohms

Array parameters Consist of a group, a line and
multiple sequential (listed)
elements, which have the same
properties but different values.

A10 Access level

} A10[0] access level: Value =
Access level via operating unit

} A10[2] access level: Value =
Access level via CANopen and
EtherCAT

} A10[4] access level: Value =
Access level via PROFINET

Record parameters Consist of a group, a line and
multiple sequential (listed)
elements, which can have different
properties and different values.

A00 Save values

} A00[0] Start: Value = Start action

} A00[1] Progress: Value = Display
action progress

} A00[2] Result: Value = Display
action result

Tab. 3: Parameter types

4.2.4 Parameter structure
Every parameter has specific coordinates with the following structure.

E250 [2] .3

Axis
Group

Line

1.

Element
Bit

} Axis (optional)
In case of multiple axes, the one to which a parameter is assigned; not applicable for global
parameters (value range: 1 – 4).

} Group
The thematic group to which a parameter belongs (value range: A – Z).

} Line
Distinguishes the parameters within a parameter group (value range: 0 – 999).

} Element (optional)
Elements of an array or record parameter (value range: 0 – 16000).

} Bit (optional)
Selection of a single bit for complete data addressing; depends on the data type 
(value range: 0 – 31).
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4.2.5 Parameter visibility
The visibility of a parameter is primarily controlled by the access level you set in DriveControlSuite
and by the properties you project for the respective drive controller (e.g. hardware, firmware and
application). A parameter can also be shown or hidden depending on other parameters or settings.
For example, the parameters of an additional function are only shown as soon as you activate the
relevant additional function.

Access level
The access options for the individual software parameters are ranked hierarchically and divided into
individual levels. This means that parameters can be hidden for a specific purpose and, relatedly,
their configuration options can be locked starting from a specific level.

Each parameter has one access level for read access (visibility) and one access level for write access
(editability). The following levels are present:

} Level 0
Elementary parameters

} Level 1
Important parameters of an application

} Level 2
Important parameters for service with extensive diagnostic options

} Level 3
All parameters needed for commissioning and optimizing an application

The parameter A10 Access level controls general access to parameters:

} Over CANopen or EtherCAT (A10[2])

} Over PROFINET (A10[3])

Information

It is not possible to write to or read the parameter hidden in DriveControlSuite during
communication via fieldbus.

Hardware
Which parameters are available to you in DriveControlSuite is determined by which series you select
in the configuration dialog for the drive controller, for example, or whether you project an option
module. Basically, the only parameters that are displayed are the ones you need to parameterize the
configured hardware.

Firmware
Due to the further development and updating of functions for the drive controllers, new parameters
and also new versions of existing parameters are continuously being implemented in
DriveControlSuite and in the firmware. The parameters are displayed in the software according to the
DriveControlSuite version used and the configured firmware version of the respective drive controller.

Applications
Applications generally differ in terms of functions and their control. For this reason, different
parameters are available with each application.
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4.3 Signal sources and process data mapping
The transmission of control signals and set values in DriveControlSuite meets the following principles.

Signal sources
Drive controllers are controlled either over a fieldbus, using mixed operation consisting of a fieldbus
system and terminals or exclusively using terminals. 
You can use the corresponding selection parameters, referred to as signal sources, to configure
whether the control signals and set values of the application are obtained over a fieldbus or using
terminals.

In case of activation over a fieldbus, parameters that are selected as data sources for control signals
or set values must be part of the subsequent process data mapping. In the case of activation using
terminals, the respective analog or digital inputs are specified directly.

Process data mapping
If you are working with a fieldbus system and have selected the source parameters for control signals
and set values, configure the fieldbus-specific settings, e.g. the assignment of the process data
channels for transmitting receive and transmit process data, as the last step. The respective
procedure can be found in the accompanying Pilz fieldbus manuals.
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4.4 Non-volatile memory
All project configurations, parameterizations and related changes to parameter values are in effect
after transmission to the drive controller, but are only stored in volatile memory.

Saving to a drive controller
To save the configuration in non-volatile memory on a drive controller, you have the following options:

} Saving the configuration using the Save values wizard:
Project menu > Wizards area > Projected axis > Save values wizard: Select the Save values
action

} Saving the configuration using the parameter list:
Project menu > Parameter list area > Projected axis > Group A: Drive controller > A00 Save
values: Set the parameter A00[0] to the value 1: Active

} Saving the configuration using the S1 operating button:
Drive controller with S1 operating button: Press and hold the operating button for 3 s

Saving to all drive controllers within a project
To save the configuration in non-volatile memory on several drive controllers, you have the following
options:

} Saving the configuration using the toolbar:
Toolbar > Save values icon: Click the Save values icon

} Saving the configuration using the Online functions window:
Project menu > Online connection button > Online functions window: Click on Save values (A00)

Information

Do not shut off the drive controller while saving. If the supply voltage to the control
unit is interrupted while saving, the drive controller will start with fault 40: Invalid data
the next time it is switched on. To successfully complete the saving procedure, the
configuration must be stored again in non-volatile memory.
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5 Commissioning
The following chapters describe how to commission your drive system using DriveControlSuite.

For the components of your axis model, we require one of the following two combinations as an
example:

Synchronous servo motor with EnDat 2.2 digital or EnDat 3 encoder (and optional
brake)
These motors are saved along with all relevant data for the project configuration in the
DriveControlSuite motor database and in the electronic nameplate. 
Upon selecting the motor from the database, such as when reading out the nameplate, all data is
transferred to the corresponding parameters. There is no need for complex parameterization of the
motor, encoder and brake.

LM Lean motor without encoder (with optional brake)
These motors are stored in the motor database of the DriveControlSuite, along with all the data
relevant for project configuration. Furthermore, the motor data and the release and engaging times of
the brake are part of the firmware. 
Upon selecting the desired motor from the database, all data is transmitted to the corresponding
parameters. The release and engaging times of the brake are also stored. If a brake is present, you
must only activate this manually. However, complex parameterization of the motor and brake is not
necessary.

For asynchronous motors, the motor data relevant for project configuration is also taken from the
motor database. All other motor types need to have their parameters configured manually.

Before you begin commissioning, make sure that the system nodes are hooked up and supplied with
control voltage.

Information

Always perform the steps described below in the specified order!

Some parameters are interdependent and do not become accessible to you until you
have first configured certain settings. Follow the steps in the specified sequence so
that you can finish the parameterization completely.
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5.1 Initiating the project
In order to be able to configure all drive controllers and axes of your drive system using
DriveControlSuite, you must record them as part of a project.

5.1.1 Projecting the drive controller and axis
Create a new project and project the first drive controller along with the accompanying axis.

Information

Make sure that you project the correct series in the Drive controller tab. The
projected series cannot be changed afterwards.

Creating a new project
1. Start DriveControlSuite.

2. On the start screen, click Create new project.

ð The new project is created and the configuration dialog for the first drive controller opens.

ð The Drive controller button is active.

Projecting the drive controller
1. Properties tab: 

Establish the relationship between your circuit diagram and the drive controller to be projected in
DriveControlSuite.

1.1. Reference:
Define the reference code (equipment code) of the drive controller.

1.2. Designation:
Give the drive controller a unique name.

1.3. Version:
Version your project configuration.

1.4. Description:
If necessary, save additional supporting information (e.g., the change history).

2. Drive controller tab:
Select the series, device type and firmware version of the drive controller.

3. Option modules tab, Safety module:
If the drive controller is part of a safety circuit, select the corresponding safety module.

4. Device control tab:
Project the basic control of the drive controller.

4.1. Device control:
Select device control Drive Based.

4.2. Rx process data, Tx process data:
If you use a fieldbus to control the drive controller, select the corresponding receive and
transmit process data.
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Projecting the axis
1. Click Axis A.

2. Properties tab: 
Establish the relationship between your circuit diagram and the axis to be projected in
DriveControlSuite.

2.1. Reference:
Define the reference code (equipment code) of the axis.

2.2. Designation:
Give the axis a unique name.

2.3. Version:
Version your project configuration.

2.4. Description:
If necessary, save additional supporting information (e.g., the change history).

3. Application tab:
Select the Drive Based Center Winder application.

4. Motor tab:
Select the type of motor you operate with this axis. If you are working with motors from third-
party suppliers, enter the accompanying motor data later.

5. Repeat the steps for axis B (only for double-axis controllers).

6. Confirm with OK.

5.1.2 Configuring safety technology
If the drive controller is part of a safety circuit, you must configure the safety technology in
accordance with the commissioning steps outlined in the corresponding manual in the next step (see
Further information [ 146]).
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5.1.3 Creating other drive controllers and modules
In DriveControlSuite, all drive controllers within a project are grouped using modules. If you add a
new drive controller to your project, be sure to always assign it to an existing module. Group drive
controllers in a module if, for example, they are located in the same control cabinet or work together
to operate the same machine part.

Creating a drive controller
1. In the project tree, select your project P1 > module M1 > context menu Create new drive

controller.

ð The drive controller is created in the project tree and the configuration dialog opens.

2. Project the drive controller as described in Projecting the drive controller and axis [ 22].

3. Repeat the steps for all other drive controllers that you want to project.

Creating a module
1. In the project tree, select your project P1 > context menu Create new module.

ð The module is created in the project tree.

2. Project the module as described in Projecting the module [ 24].

3. Repeat the steps for all other modules that you want to project.

5.1.4 Projecting the module
Give your module a unique name, enter the reference code and, as an option, store additional
information like the version and change history of the module.

1. Select the module in the project tree and click on Project configuration in the project menu.

ð The configuration dialog for the module opens.

2. Establish the relationship between your circuit diagram and the module in DriveControlSuite.

2.1. Reference:
Define the reference code (equipment code) of the module.

2.2. Designation:
Give the module a unique name.

2.3. Version:
Version the module.

2.4. Description:
If necessary, save additional supporting information (e.g., the change history).

3. Confirm with OK.
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5.1.5 Projecting the project
Give your project a unique name, enter the reference code and, as an option, store additional
information like the version and change history of the project.

1. Select the project in the project tree and click on Project configuration in the project menu.

ð The configuration dialog for the project opens.

2. Establish the relationship between your circuit diagram and the project in DriveControlSuite.

2.1. Reference:
Define the reference code (equipment code) of the project.

2.2. Designation:
Give the project a unique name.

2.3. Version:
Version the project.

2.4. Description:
If necessary, save additional supporting information (e.g., the change history).

3. Confirm with OK.
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5.2 Mapping the mechanical axis model
To be able to put your real drive train with one or more drive controllers into operation, you must map
your complete mechanical environment in DriveControlSuite.

The 6th generation of Pilz drive controllers are specially developed for communication between the
drive controller and controller on the basis of the actual variables at the output (° or mm of real axis
movement). The scaling of the axis model is calculated by the drive controller's firmware
independently of the encoder model, without any rounding errors or drift.

5.2.1 Parameterizing the motor
You have projected one of the following motors:

Synchronous servo motor with EnDat 2.2 digital encoder or EnDat 3 (with optional
brake)
By projecting the corresponding motor, limiting values for currents and torques as well as associated
temperature data are automatically transferred to the respective parameters of the individual wizards.
All additional data on the brake and encoder is transferred at the same time.

Lean motor without encoder (with optional brake)
By projecting the corresponding motor, limiting values for currents and torques as well as associated
temperature data are automatically transferred to the respective parameters of the individual wizards.
You only have to parameterize the cable length in use. Even the brake purging and engaging times
are already stored. You just have to activate the brake.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in
the Project menu > Wizard area.

2. Select the Motor wizard.

3. B101 Cable length:
Select the cable length of the power cable in use.

4. Repeat the steps for the 2nd axis (only for double-axis controllers).

Then activate the brake.

1. Select the relevant drive controller in the project tree and click on the first projected axis in the
Project menu > Wizard area.

2. Select the Brake wizard.

3. F00 Brake:
Select 1: Active.

4. Repeat the steps for the 2nd axis (only for double-axis controllers).

Motor protection
The drive controller has an i²t model of the motor, a computational model for thermal monitoring of the
motor. To activate it and set up the protective function, configure the following settings (deviating from
the presets): U10 = 2: Warning and U11 = 1.00 s. This model can be used instead of or in addition to
temperature-monitored motor protection.
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5.2.2 Parameterizing the axis model
Parameterize the setup of your drive in this order:

} Define the axis model

} Scale the axis

} Parameterize the position and velocity window

} Limit the axis (optional)

• Limit the position

• Limit the velocity, acceleration and jerk

• Limit the torque and force

Information

If you are using a double-axis controller with two projected axes, you must
parameterize the axis model for each axis individually.
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5.2.2.1 Define the axis model
1. Select the relevant drive controller in the project tree and click on the desired projected axis in

the Project menu > Wizard area.

2. Select the Axis model wizard.

3. I05 Type of axis:
Define whether the axis type is rotational or translational.

3.1. If you would like to configure the units of measure and the number of decimal places
individually for specifying and displaying positions, velocities, accelerations and jerk,
select 0: User defined, rotational or 1: User defined, translational.

3.2. If the units of measure and the number of decimal places for specifying and displaying
positions, velocities, accelerations and jerk are to be fixed, select 2: Rotational or 
3: Translational.

4. B26 Motor encoder:
Define the interface to which the motor encoder is connected.

5. I02 Position encoder (optional):
Define the interface to which the position encoder is connected.

6. I00 Position range:
Define whether the travel range of the axis is limited or endless (modulo).

7. If you select I00 = 1: Endless, parameterize a revolution length when you scale the axis.

Information

When you parameterize I05 Type of axis, you can either use selection 0: User
defined, rotational or 1: User defined, translational to configure units of measure and
the number of decimal places for the axis model individually or use selections 
2: Rotational and 3: Translational to revert to preset values.

Selection 0: User defined, rotational and selection 1: User defined, translational let
you configure the unit of measure (I09) and the decimal places (I06) individually.
Velocity, acceleration and jerk are represented as the derivative of the unit of
measure with respect to time.

Selection 2: Rotational sets the following units of measure for the axis model:
position in °, velocity in rpm, acceleration in rad/s2, jerk in rad/s3.

Selection 3: Translational sets the following units of measure for the axis model:
position in mm, velocity in m/s, acceleration in m/s2, jerk in m/s3.

Information

If you do not parameterize it differently for I02 Position encoder, B26 Motor encoder
is used for position control as standard.
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5.2.2.2 Scale the axis
1. Select the relevant drive controller in the project tree and click on the desired projected axis in

the Project menu > Wizard area.

2. Select the Axis model wizard > Axis: Scaling.

3. Scale the axis by configuring the overall gear ratio between the motor and output.
To simplify this scaling for you, you are provided with the scaling calculator Conversion of
positions, velocities, accelerations, torque/force, which calculates the effects of changed motion
variables on the entire system.

4. I01 Circular length:
If you have selected 1: Endless for I00 Position range, enter the revolution length.

5. I06 Decimal places position (optional):
If you have selected 0: User defined, rotational or 1: User defined, translational for I05 Type of
axis, define the desired number of decimal places.

6. I09 Measure unit (optional):
If you have selected 0: User defined, rotational or 1: User defined, translational for I05 Type of
axis, define the desired unit of measure.

7. I03 Axis polarity:
Use the polarity to specify the direction of interpretation between the axis movement and motor
movement.

Information

A change to parameter I06 moves the decimal separator for all axis-specific position
values! Ideally, define I06 before parameterizing other position values and then
check them.

If the axis receives set value specifications from a controller or follows the master
values of a master, the resolution of position values directly impacts the smooth
operation of the axis. Therefore, you should define a sufficient number of decimal
places appropriate for your application.

Information

Parameter I297 Maximum speed position encoder must be parameterized according
to your application case. If I297 is set too low, the permitted maximum speed is
exceeded even at normal operating speeds. On the other hand, if I297 is set too
high, measuring errors of the encoder can be overlooked.

I297 depends on the following parameters: I05 Type of axis, I06 Decimal places
position, I09 Measure unit as well as I07 Distance factor numerator position and
I08 Distance factor denominator position or A585 Feed constant for CiA 402. If you
have made changes to one of the parameters listed, select I297 accordingly as well.
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5.2.2.3 Parameterizing the position and velocity window
Enter position limits and velocity zones for set values. To do so, parameterize boundary values for
reaching a position or velocity.

1. Select the Axis model wizard > Window position, velocity.

2. C40 Velocity window:
Parameterize a tolerance window for velocity tests.

3. I22 Target window:
Parameterize a tolerance window for position tests.

4. I87 Actual position in window time:
Parameterize how long a drive must stay in the specified position window before a
corresponding status message is output.

5. I21 Maximal following error:
Parameterize a tolerance window for lag tests.

For more information on monitoring the lag, see Lag monitoring [ 142].

5.2.2.4 Limiting the axis
As an option, you can limit the maximum permitted motion variables of position, velocity, acceleration,
jerk and torque/force according to your application.

Information

To simplify the scaling and limiting of the axis, the Axis model wizard > Axis: Scaling
provides you with the Conversion of position, velocities, accelerations, torque/
force scaling calculator, which calculates the effects of changed motion variables on
the entire system. You can use the scaling calculator to enter values for motion
variables of the motor, gear unit output and axis in order to convert the values to all
other locations in the axis model.

Limiting the position
To secure the travel range of the axis, you have the option to limit the permitted positions using a
software or hardware limit switch.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in
the Project menu > Wizard area.

2. Select the Axis model wizard > Limit: Position.

3. I101 Source positive /limit switch, I102 Source negative /limit switch:
To limit the travel range of the axis via hardware limit switches, select the source of the digital
signal that is used to evaluate a limit switch at the positive or negative end of the travel range.

3.1. If a fieldbus is the source, select 2: Parameter.

3.2. If a digital input (direct or inverted) acts as the source, select the corresponding input.

4. I50 Software stop positive, I51 Software stop negative:
To limit the travel range of the axis via software limit switches, define the largest or smallest
permitted position for software position limiting.
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Limiting velocity, acceleration, jerk
As an option, you can limit the motion variables of velocity, acceleration and jerk and define the quick
stop deceleration according to your application. The default values are designed for slow velocities
without gear units.

1. Select the Motor wizard.

2. B83 v-max motor:
Determine the maximum permitted velocity of the motor.

3. Select the Axis model wizard > Axis: Scaling.

4. Conversion of positions, velocities, accelerations, torque/force area:
Use the scaling calculator to determine the maximum permitted velocity of the output using the
maximum permitted velocity of the motor.

5. Select the Axis model wizard > Limit: Velocity, acceleration, jerk.

6. I10 Maximal speed:
Define the maximum permitted velocity for the output.

7. I11 Maximal acceleration:
Define the maximum permitted acceleration for the output.

8. I16 Maximal jerk:
Define the maximum permitted jerk for the output.

9. I17 Quickstop deceleration: 
Define the desired quick stop deceleration for the output.

10. Repeat the steps for axis B (only for double-axis controllers).

Limiting torque/force
As an option, you can limit the torque/force according to your application. The default values take into
account the rated operation together with the overload reserves.

1. Select the Axis model wizard > Limit: Torque/force.

2. C03 Maximum positive torque/force, C05 Maximum negative torque/force:
Define the maximum permitted set torque/maximum permitted set force.

3. C08 Maximum torque/force for quick stop:
Define the maximum permitted set torque/maximum permitted set force in case of a quick stop
and in case of drive-controlled emergency stop SS1, SS1 and SS2.
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5.3 Referencing absolute position
When commissioning a system with position measurement systems, the relation of a measured to an
actual axis position must be determined to be able to work with absolute positions.

If you are working with absolute positions, reference the axis now. Otherwise, proceed by
parameterizing application-specific conditions and responses of the Drive Based device control.

Information

If you are using a double-axis controller with two projected axes, you must reference
the absolute position for each axis individually.

5.3.1 Defining the referencing method
1. Select the relevant drive controller in the project tree and click on the desired projected axis in

the Project menu > Wizard area.

2. Select the Referencing wizard.

3. I30 Referencing type, I31 Referencing direction, I35 Referencing with zero pulse:
Define the characteristics for referencing.
For information on possible combinations of the named characteristics as well as detailed
descriptions of the individual referencing methods, see Referencing methods [ 105].

4. I43 Move to reference position:
If the axis is to automatically move to the referenced position after referencing, set this
parameter to 1: Active.

5.3.2 Parameterizing the reference switch
If you are working with absolute positions and would like to determine a reference position while
referencing using the reference switch, proceed as follows.

1. Select the Drive Based Center Winder application wizard > Data sources > Application digital
signals: Data source.

2. I103 Source reference switch:

2.1. If a digital input (direct or inverted) acts as the source, select the corresponding input.

2.2. If bit 3 of the control word I210 of the application is the source, select 2: Parameter.
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5.3.3 Setting the reference
If you are working with absolute positions and would like to reference without using a referencing run,
the value of the current actual position is applied directly as a parameter value from I34 using the Set
reference signal.

1. Select the Drive Based Center Winder application wizard > Data sources > Application digital
signals: Data source.

2. I111 Source set reference:

2.1. If a digital input (direct or inverted) acts as the source, select the corresponding input.

2.2. If bit 11 of the control word I210 of the Drive Based Center Winder application is the
signal source, select 2: Parameter.

5.3.4 Parameterizing the limit switch
Using the limit switch, you can limit the travel range in the positive and negative direction using
sensor signals, regardless of the operating mode. Both signals are protected against wire breaks 
(= low active, i.e. a low level leads to a limit switch fault).

Parameterizing a positive limit switch
1. Select the Drive Based Center Winder application wizard > Data sources > Application digital

signals: Data source.

2. I101 Source positive /limit switch:
To limit the travel range in the positive direction of motion, select the source for the positive limit
switch.

2.1. If a digital input (direct or inverted) acts as the source, select the corresponding input.

2.2. If bit 1 of the control word I210 of the application is the source, select 2: Parameter.

Parameterizing a negative limit switch
1. Select the Drive Based Center Winder application wizard > Data sources > Application digital

signals: Data source.

2. I102 Source negative /limit switch:
To limit the travel range in the positive direction of motion, select the source for the negative limit
switch.

2.1. If a digital input (direct or inverted) acts as the source, select the corresponding input.

2.2. If bit 2 of the control word I210 of the application is the source, select 2: Parameter.
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5.4 Parameterizing Drive Based device control
The Drive Based device control describes the control sequence of a drive controller based on a state
machine, i.e. a drive controller switches its state due to an event. Some of the conditions and
responses coupled with the state transitions can be influenced depending on the application; for
example, it is possible to define the end of a quick stop or enable signal delays tailored to the
respective application case.

Detailed information on the device control and Drive Based device state machine can be found in the
chapter Drive Based device control [ 133].

5.4.1 Parameterizing transition conditions
ü You have projected a drive controller with the Drive Based device control.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in
the Project menu > Wizard area.

2. Select the Drive Based device control wizard.

3. A34 Auto start:
If the drive controller is to switch directly to the Operation enabled state after the Switch on
disabled state, activate this parameter.

4. A43 Enable switch-on/off delay
If you need to hide possible fault or test pulses on the enable signal input, enter the maximum
internal activation and deactivation delay.

5. A44 Quick stop at enable off:
If the drive is to be stopped with a quick stop in the event of a deactivated enable signal, activate
this parameter.

6. A60 Source additional enable:
If you are working with multiple enable signals, define the source of additional signals in this
parameter.

7. A29 Quick stop in case of fault:
If the drive is to be stopped with a quick stop—if possible—in case of a fault, activate this
parameter. If the parameter is deactivated, motion of the axis is no longer controlled by the drive
controller.

8. A39 Maximum quick stop duration for enable off:
If you have selected 1: Active for parameter A44, define the maximum time after which the
power unit is switched off in A39.

9. A45 Quick stop end:
In this parameter, define whether a quick stop is considered ended when the drive is at a
standstill or when the quick stop request is canceled.

10. A62 Source /quick stop: 
Define how a quick stop is triggered in this parameter.

11. E48 Device control state:
Shows the current state of the drive controller.

12. If you are using a double-axis controller, click in the project menu > Wizard area on the second
projected axis and repeat the steps.
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5.5 Transmitting and saving the configuration
In order to transmit and save the configuration to one or more drive controllers, you must connect
your PC and the drive controllers over the network.

WARNING!

Injury to persons and material damage due to axis movement!

If there is an online connection between DriveControlSuite and the drive controller,
changes to the configuration can lead to unexpected axis movements.

▪ Only change the configuration if you have visual contact with the axis.

▪ Make sure that no people or objects are within the travel range.

▪ For access via remote maintenance, there must be a communication link
between you and a person on site with eye contact to the axis.

Information

During the search, all drive controllers within the broadcast domain are found via
IPv4 limited broadcast.

Requirements for finding a drive controller in the network:

▪ Network supports IPv4 limited broadcast

▪ All drive controllers and the PC are in the same subnet (broadcast domain)

ü The drive controllers are switched on and can be found in the network.

1. In the project tree, select the module under which you have recorded your drive controller and
click Online connection in the project menu.

ð The Add connection dialog box opens. All drive controllers found via IPv4 limited broadcast
are displayed.

2. Direct connection tab, IP address column: 
Activate the IP addresses in question and confirm your selection with OK.

ð The Online functions window opens. All drive controllers connected through the selected IP
addresses are displayed.

3. Select the module and the drive controller to which you would like to transfer the configuration.
Change the selection of transmission type from Read to Send.

4. Change the selection Create new drive controller:
Select the configuration that you would like to transfer to the drive controller.

5. Repeat steps 3 and 4 for all other drive controllers to which you would like to transfer your
configuration.

6. Online tab:
Click Establish online connections.

ð The configurations are transferred to the drive controllers.
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Saving a configuration

ü You have successfully transferred the configuration.

1. Online functions window, Online tab, Actions for drive controller in online operation area:
Click Save values (A00).

ð The Save values (A00) window opens.

2. Select on which drive controllers you want to save the configuration.

3. Click Start action.

ð The configuration is stored on the drive controllers in non-volatile memory.

4. Close the Save values (A00) window.

Information

For the configuration to take effect on the drive controller, a restart is required: for
example, after the configuration is saved on the drive controller for the first time or
when changes are made to the firmware or process data mapping.

Restarting a drive controller

ü You have stored the configuration on the drive controller in non-volatile memory.

1. Online functions window, Online tab:
Click Restart (A09).

ð The Restart (A09) window opens.

2. Select which of the connected drive controllers you want to restart.

3. Click Start action.

4. Confirm the safety note with OK.

ð The Restart (A09) window closes.

ð The fieldbus communication and connection between DriveControlSuite and drive controllers are
interrupted.

ð The selected drive controllers restart.
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5.6 Testing the configuration
Check the configuration of your projected axis model before continuing with the parameterization of
the application. Use Jog control panel to test the electronic and mechanical data of your project
configuration and parameterization for plausibility. Control panel motion gives you the option to test
the basic movements of your axis using motion commands.

Information

Check the suitability of the default values for your application before starting the test.
If they appear too large or unsuitable compared with the results of the scaling
calculator, replace them with values that are more suitable for test operation.

5.6.1 Testing jog mode
Jog control panel provides various commands for jog mode which you can use to test the
configuration of your projected axis model for plausibility.

Information

Make sure that the values of the control panel are compatible with your projected
axis model in order to obtain useful test results that you can use to optimize your
configuration for the respective axis.

The scaling calculator is available under the Axis model wizard > Axis: Scaling to
recalculate the values for the control panel according to your projected axis model.

WARNING!

Injury to persons and material damage due to axis movement!

When you activate the control panel, DriveControlSuite gives you sole control of the
motions of the axis. If you are using a controller, it no longer monitors the axis
movements after the control panel is activated. The controller cannot intervene to
prevent collisions. The controller takes over control again when the control panel is
deactivated, which can cause unexpected axis movements.

▪ Do not switch to other windows when the control panel is active.

▪ Only use the control panel if you have visual contact with the axis.

▪ Make sure that no people or objects are within the travel range.

▪ For access via remote maintenance, there must be a communication link
between you and a person on site with eye contact to the axis.
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Testing the configuration using the jog control panel

ü There is an online connection between DriveControlSuite and the drive controller.

ü You have successfully stored the configuration on the drive controller.

ü No safety function is active.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in
the Project menu > Wizard area.

2. Select the Jog control panel wizard.

3. Click Control panel on and then Enable.

ð The axis is monitored via the active control panel.

4. Check the default values of the control panel and adjust them to your projected axis model if
necessary.

5. To test the configuration of your projected axis for direction of motion, velocity, etc., move the
axis gradually using the Jog+, Jog-, Jog step+ and Jog step- buttons.

6. Use your test results to optimize your configuration as necessary.

7. To deactivate the control panel, click on Control panel off.

Information

Jog+ and Jog− cause a continual manual movement in the positive or negative
direction. Jog step+ and Jog step- move the axis relative to the current actual
position by the increment specified in I14.

Jog+ and Jog− have a higher priority than Jog step+ and Jog step−.
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5.6.2 Testing the motion commands
Control panel motion provides a standard set of motion commands which you can use to test the
basic movements of your axis. The command set is based on the PLCopen standard and
supplemented by manufacturer-specific motion commands.

If you are working with absolute position measuring systems and need the MC_MoveAbsolute motion
command for testing, you must reference an absolute position in advance (see Referencing absolute
position [ 32]).

Information

Make sure that the values of the control panel are compatible with your projected
axis model in order to obtain useful test results that you can use to optimize your
configuration for the respective axis.

The scaling calculator is available under the Axis model wizard > Axis: Scaling to
recalculate the values for the control panel according to your projected axis model.

WARNING!

Injury to persons and material damage due to axis movement!

When you activate the control panel, DriveControlSuite gives you sole control of the
motions of the axis. If you are using a controller, it no longer monitors the axis
movements after the control panel is activated. The controller cannot intervene to
prevent collisions. The controller takes over control again when the control panel is
deactivated, which can cause unexpected axis movements.

▪ Do not switch to other windows when the control panel is active.

▪ Only use the control panel if you have visual contact with the axis.

▪ Make sure that no people or objects are within the travel range.

▪ For access via remote maintenance, there must be a communication link
between you and a person on site with eye contact to the axis.
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Testing the configuration using the motion control panel

ü There is an online connection between DriveControlSuite and the drive controller.

ü You have successfully stored the configuration on the drive controller.

ü No safety function is active.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in
the Project menu > Wizard area.

2. Select the Control panel motion wizard.

3. Click Control panel on and then Enable.

ð The axis is monitored via the active control panel.

4. Check the default values of the control panel and adjust them to your projected axis model if
necessary.

5. K402 Command: 
Select the desired command and define the position, velocity, acceleration, deceleration and
jerk.

6. Execute the command by clicking Start.

7. To test the configuration of your projected axis for direction of motion, velocity, etc., move the
axis precisely using the individual commands.

8. Use your test results to optimize your configuration as necessary.

9. To deactivate the control panel, click on Control panel off.
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5.7 Parameterizing the Drive Based Center Winder application
The Drive Based Center Winder application provides two operating modes: center winder operating
mode and command operating mode.

Center winder operating mode concentrates on the 30: MC_Winder motion command, which is
essential for winding. Command operating mode additionally provides you with a standard set of
motion commands based on PLCopen, which is supplemented by your own motion commands. The
operating mode that is best suited to your application depends on your application case. If you are
coordinating motion sequences using a controller and need different motion commands, use the
command operating mode. If you are not using a controller or only need the motion command for
winding, select the center winder operating mode.

The general motion variables are grouped in the mode-independent Data sources wizard. Depending
on the operating mode, unique wizards are also available which you can use to parameterize
operating mode-specific motion variables. The general or operating mode-specific motion variables
you need to parameterize depend on your drive project.

If you would like to use set values from external sources for your project, parameterize them in the
first step. Then, continue with the operating mode-specific motion variables in the respective wizards.

Information

A drive controller can only process the motion commands of one operating mode for
each projected axis. If you are using a double-axis controller with two projected
axes, you must configure the operating mode for each axis individually.

To configure the Drive Based Center Winder application, follow the handling
instructions for the operating mode in which you want to operate the corresponding
axis.

5.7.1 General motion variables and signal sources
First, parameterize the general motion variables and signal sources before you begin
parameterization of the operating mode-specific motion variables. The motion variables that you need
to parameterize depend on your drive project.

Information

If you are using a double-axis controller with two projected axes, you must configure
the shared motion variables and signal sources for each axis individually.
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5.7.1.1 Velocity – Parameterizing sources
If you are obtaining the set value for velocity from external sources for applications of the Drive Based
Center Winder type, enter this as described below.

If you transmit data via fieldbus, the set value can either be obtained directly from an internal
parameter or indirectly by reading out a parameter (such as with PID controllers).

Set velocity – Parameterizing the source
If you are obtaining the set value for velocity from an external source, enter the source for the main
set value.

ü Use the motion command MC_MoveSpeed or MC_MoveVelocity.

1. Select the Drive Based Center Winder application wizard > Data sources > External velocity:
Data source.

2. G461 Source external velocity:

2.1. If you are transmitting data via fieldbus and would like to configure the value as the
general data source, select 4: Parameter G460.

2.2. If the set value is read out indirectly via a parameter, select 5: Indirect read parameter
G811.

3. G460 External velocity:
If you have selected 4: Parameter G460 for G461, enter the set velocity here.

4. G811 Indirect read external velocity:
If you have selected 5: Indirect read parameter G811 for G461, enter the associated parameter
coordinate here.

Additional velocity – Parameterizing the source
If you also want to regulate the set velocity, enter the source for the additional set value.

ü Use the motion command MC_MoveSpeed or MC_MoveVelocity.

ü You obtain the set velocity from an external source.

1. Select the Drive Based Center Winder application wizard > Data sources > External additional
velocity: Data source.

2. G464 Source external additional velocity:

2.1. If you are transmitting data via fieldbus and would like to configure the value as the
general data source, select 4: Parameter G463.

2.2. If the set value is read out indirectly via a parameter, select 5: Indirect read parameter
G812.

3. G463 External additional velocity:
If you have selected 4: Parameter G463 for G464, enter the set velocity here.

4. G812 Indirect read additional external velocity:
If you have selected 5: Indirect read parameter G812 for G463, enter the parameter coordinate
here.
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5.7.1.2 Velocity override – Parameterizing the source
If you would like to use a velocity override to scale the velocity profile of your motion commands,
enter the source for the velocity override.

If you transmit data via fieldbus, the set value can either be obtained directly from an internal
parameter or indirectly by reading out a parameter (such as with PID controllers).

1. Select the Drive Based Center Winder application wizard > Data sources > Velocity override:
Data source.

2. G467 Source velocity override:

2.1. If you are transmitting data via fieldbus and would like to configure the value as the
general data source, select 4: Parameter G466.

2.2. If the set value is read out indirectly via a parameter, select 5: Indirect read parameter
G813.

3. G466 Velocity override:
If you have selected 4: Parameter G466 for G467, enter the set velocity here.

4. G813 Indirect read velocity override:
If you have selected 5: Indirect read parameter G813 for G467, enter the parameter coordinate
here.

5.7.1.3 Torque/Force – Parameterizing sources
If you have selected the motion command MC_TorqueControl for Drive Based Center Winder type
applications and obtain set values from external sources, enter the sources for the set torque/force
and velocity bracketing.

If you transmit data via fieldbus, the set value can either be obtained directly from an internal
parameter or indirectly by reading out a parameter (such as with PID controllers).

Set torque/force – Parameterizing the source
If you obtain the set value for torque/force from an external source, enter the source for the set
torque/force.

ü You are using the 9: MC_TorqueControl motion command.

1. Select the Drive Based Center Winder application wizard > Data sources > Set torque/force,
velocity bracketing: Data source.

2. G470 Source torque/force reference:

2.1. If you are transmitting data via fieldbus and would like to configure the value as the
general data source, select 4: Parameter G469.

2.2. If the set value is read out indirectly via a parameter, select 5: Indirect read parameter
G814.

3. G469 Torque/Force reference:
If you have selected 4: Parameter G469 for G470, define the value for set torque/force here. The
value relates to C03 Maximum positive torque/force and C05 Maximum negative torque/force.

4. G814 Indirect read torque/force reference:
If you have selected 5: Indirect read parameter G814 for G470, define the associated parameter
coordinate here.

5. G500 Torque/force ramp removal, G501 Torque/force ramp removal:
Define the ramps for the build-up or reduction of torque/force.
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Velocity bracketing – Parameterizing the source
If you obtain values for limiting the velocity from an external source, enter the source for the velocity
bracketing.

ü You are using the 9: MC_TorqueControl motion command.

1. Select the Drive Based Center Winder application wizard > Data sources > Set torque/force,
velocity bracketing: Data source.

2. G473 Source velocity bracketing positiv:

2.1. If you are transmitting data via fieldbus, select 4: Parameter G472.

3. G472 Velocity bracketing positiv:
If you have selected 4: Parameter G472 for G473, define the maximum limit that you want to
permit for your mechanical system.

4. G476 Source velocity bracketing negative:

4.1. If you are transmitting data via fieldbus, select 4: Parameter G475.

5. G475 Velocity bracketing negative:
If you have selected 4: Parameter G475 for G476, define the maximum limit that you want to
permit for your mechanical system here.

Information

If you define the velocity bracketing using G472 or G475, you should allow the
control enough room. Therefore, select a value for the velocity bracketing that is
greater than 1%. G472 and G475 refer to I10 Maximal speed.
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5.7.2 Parameterizing center winder operating mode
The following graphic shows the signal flows of center winder operating mode. The elements shown
in a lighter shade are optional.

Motion
core

DI

Controller

AI

Controller

Controller

Start

Motion
variables

Motor

Start signal

Override

Alternative
sources

Fig. 3: Center winder operating mode: signal flows

In center winder operating mode, the 30: MC_Winder motion command is permanently stored on the
drive controller with associated set values. This allows you to use set values for the material velocity
and material tensile force for various winding applications, e.g. for winding, unwinding or rewinding
materials such as plastic, wire, textiles or paper.

In center winder operating mode, drive controllers are either activated using a fieldbus or by a mixed
operation of a fieldbus and terminals.

Proceed as follows ...
} Activate center winder operating mode.

} Parameterize the source of the winding diameter (calculator or sensor).

} Compensate for the friction and, optionally, the mass inertia of the axis.

} Parameterize the set material velocity and velocity override for the set velocity of the motor.

} Parameterize the actual material velocity.

} Parameterize the set material tensile force.
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Information

The motion variables available for this operating mode that you configure in the
software depend on your application case as well as on additional project-specific
factors such as the use of a controller or the type of data transmission (fieldbus,
terminals).

5.7.2.1 Activating center winder operating mode
1. Select the relevant drive controller in the project tree and click on the desired projected axis in

the Project menu > Wizard area.

2. Select the Drive Based Center Winder application wizard.

3. Operating modes area:
Activate the option for center winder operating mode.

ð The associated wizards are available for parameterizing the operating mode.

ð The 30: MC_Winder motion command is selected in the background.

5.7.2.2 Parameterizing the diameter source
Parameterize the source of the winding diameter for the calculation of the material tensile force based
on whether a sensor serves as the source for the diameter in your drive project or whether the
diameter is calculated by the drive controller. First configure the general settings as described below,
then parameterize either the diameter sensor or the diameter calculator, depending on the source.

Parameterizing the diameter
Parameterize the minimum and maximum permitted winding diameters and optionally define the time
constant for the filter of the winding diameter.

1. Select the Drive Based Center Winder application wizard > Center winder > Diameter.

2. L03 Minimal diameter:
Define the minimum permitted diameter of the winding (usually corresponds to the winder case).

3. L04 Diameter maximum:
Define the maximum permitted diameter of the winding according to your application.

4. L111 Diameter time constant:
If the quality of the signal requires it, adjust the time constant for the filter accordingly.
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Parameterizing the diameter source
Select either a sensor or the diameter calculator as the source for the winding diameter.

1. Select the Drive Based Center Winder application wizard > Center winder > Diameter >
Diameter determination.

2. L20 Source diameter:
Select the source for the winding diameter.

2.1. If the drive controller is to calculate the winding diameter, select 0: Diameter calculator.

2.2. If a sensor is the source for the winding diameter, select 1: Diameter sensor.

ð The parameters and wizards for parameterization of the winding diameter are displayed
according to the selected source.

Parameterizing the diameter limit
As an option, you can limit the winding direction or maximum permitted change in the winding
diameter per second.

1. Select the Drive Based Center Winder application wizard > Center winder > Diameter >
Diameter limit.

2. L35 Winding direction:
Define the winding direction.

2.1. If the winding diameter is allowed to both increase and decrease, select 0: Inactive.

2.2. If the winding diameter should only increase, select 1: Wind.

2.3. If the winding diameter should only decrease, select 2: Unwind.

2.4. If the control word of the center winder is the source for selecting the winding direction,
select 3: Parameter L150.

3. L36 Diameter change maximum:
Define the maximum permitted change in the winding diameter per second.

5.7.2.2.1 Parameterizing the diameter sensor
If a sensor serves as the source for the winding diameter, parameterize a fieldbus as the source.

ü The winding diameter is measured using a sensor (L20 = 1: Diameter sensor).

1. Select the Drive Based Center Winder application wizard > Center winder > Diameter >
Diameter determination.

2. L21 Source diameter sensor:
Select the source for the diameter sensor.

2.1. If a fieldbus is the source, select 4: Parameter L25.
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5.7.2.2.2 Parameterizing the diameter calculator
If the winding diameter is calculated by the drive controller, parameterize the diameter calculator as
described below.

Information

The winding diameter is required for a consistent calculation of the material tensile
force. When L20 = 0: Diameter calculator, it is calculated by the drive controller from
the actual velocity of the motor and actual material velocity, among other factors.
Accordingly, the winding diameter cannot be calculated when the axis is at a
standstill. This means that, depending on the actual winding diameter, a material
tensile force that is temporarily too low can result when continuing the 
30: MC_Winder motion command.

There are 2 options for enabling a consistent material tensile force when continuing
the 30: MC_Winder motion command from a standstill: You can either maintain the
calculated winding diameter during the axis standstill or temporarily specify a start
diameter via fieldbus when continuing the 30: MC_Winder motion command
(maintain diameter: L28; start diameter: L30).

Parameterizing the diameter calculator
Parameterize the minimum permitted velocity for the calculation of the winding diameter and
optionally the function for maintaining the diameter during a standstill via fieldbus.

ü The winding diameter is calculated by the drive controller (L20 = 0: Diameter calculator).

1. Select the Drive Based Center Winder application wizard > Center winder > Diameter >
Diameter determination.

2. L02 Velocity minimum:
Select the minimum permitted velocity to be used for calculating the winding diameter.

3. L28 Diameter hold:
If the center winder control word L150 is the source for maintaining the winding diameter, select
2: Parameter L150.
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Diameter calculator: Parameterizing the filter
If the quality of the signals requires it, as an option, you can define the velocity-dependent time
constant for the filter of the diameter calculator.

ü The winding diameter is calculated by the drive controller (L20 = 0: Diameter calculator).

1. Select the Drive Based Center Winder application wizard > Center winder > Diameter >
Diameter determination > Diameter calculator: Filter.

2. L80 Diameter calculator filter time constant, L81 Diameter calculator filter velocity:
To filter the actual material velocity, actual velocity of the axis and winding diameter calculated
from it, define the velocity-dependent time constants for the diameter calculator.

2.1. L80 Diameter calculator filter time constant:
If the quality of the signals requires it, define the time constants in L80[0] – [7] for the
respective velocity in L81[0] – [7].

2.2. L81 Diameter calculator filter velocity:
If the quality of the signals requires it, define the velocities in L81[0] – [7] for the
respective time constant in L80[0] – [7].

ð The velocity-dependent time constant for the calculation of the winding diameter is calculated
from the pairs of values for L80 and L81 (display: L82).

Diameter calculator: Parameterizing the start diameter
As an option, you can activate specification of a start diameter via fieldbus for the continuation of the
30: MC_Winder motion command from a standstill.

ü The winding diameter is calculated by the drive controller (L20 = 0: Diameter calculator).

1. Select the Drive Based Center Winder application wizard > Center winder > Diameter >
Diameter limit.

2. L30 Activate start diameter:
Activate specification of a start diameter via fieldbus.

2.1. If the control word of the center winder is the source for activating the start diameter,
select 2: Parameter L150.
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5.7.2.3 Compensating for friction and mass inertia
To enable a consistent winding result, the static and dynamic frictional torque of the axis must be
determined and compensated for. Parameterize compensation for the friction as described below.

As an option, the constant and variable mass moment of inertia of the axis can also be determined
and compensated for in order to keep the material tensile force constant the axis is accelerated.
Parameterize compensation for the mass inertia as described below or deactivate the function using
the corresponding override.

For more information on friction and mass inertia compensation, see Compensation for friction and
mass inertia [ 94].

5.7.2.3.1 Determining frictional torques
Determine the static and dynamic frictional torque using the jog control panel and the respective
formula as described below.

WARNING!

Injury to persons and material damage due to axis movement!

When you activate the control panel, DriveControlSuite gives you sole control of the
motions of the axis. If you are using a controller, it no longer monitors the axis
movements after the control panel is activated. The controller cannot intervene to
prevent collisions. The controller takes over control again when the control panel is
deactivated, which can cause unexpected axis movements.

▪ Do not switch to other windows when the control panel is active.

▪ Only use the control panel if you have visual contact with the axis.

▪ Make sure that no people or objects are within the travel range.

▪ For access via remote maintenance, there must be a communication link
between you and a person on site with eye contact to the axis.
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Jog control panel: Determining operating points
To determine the static and dynamic frictional torque, move the center winder without material using
the jog control panel at 2 different velocities and write down the pair of values of velocity and
associated torque for the 2 operating points.

ü There is an online connection between DriveControlSuite and the drive controller.

ü The winder case is empty; no material is wound up.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in
the Project menu > Wizard area.

2. Select the Jog control panel wizard.

3. Click Control panel on and then Enable.

ð The axis is monitored via the active control panel.

4. Check the default values of the control panel and adjust them to your projected axis model if
necessary.

5. I12 Jog velocity:
Define the lower velocity and move the axis according to the winding direction with Jog+ or Jog-.

6. I88 Actual speed, E02 Actual torque/force filtered:
Write down the absolute value of the actual velocity as well as the associated torque as
operating point 1 for the calculation of the frictional torques (n2.1, M2.1).

7. I12 Jog velocity:
Define the higher velocity and move the axis according to the winding direction with Jog+ or
Jog-.

8. I88 Actual speed, E02 Actual torque/force filtered:
Write down the absolute value of the actual velocity as well as the associated torque as
operating point 2 for the calculation of the frictional torques (n2.2, M2.2).

ð You have determined operating point 1 (n2.1, M2.1) and operating point 2 (n2.2, M2.2) for the
calculation of the frictional torques.
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Determining static and dynamic frictional torque
To calculate the static frictional torque MRstat and dynamic frictional torque MRdyn, you need the
following absolute values:

} Operating point 1 (lower velocity)

• M2.1: torque at the gear unit output

• n2.1: speed at the gear unit output

} Operating point 2 (higher velocity)

• M2.2: torque at the gear unit output

• n2.2: speed at the gear unit output

Use the following formula for the measured value pairs to determine the dynamic frictional torque
MRdyn and write down the result (target parameter: L120).

2, 2 2, 1
Rdyn

2, 2 2, 1

1

M MM
n n

1000 min-

-
=

-

Fig. 4: Dynamic frictional torque MRdyn

Use the following formula for the measured value pairs to determine the static frictional torque MRstat

and write down the result (target parameter: L110).

2, 2 2, 1
Rstat 2, 2 Rdyn 2, 1 Rdyn1 1

n nM M M M M
1000 min 1000 min- -
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Fig. 5: Static frictional torque MRstat

Example
} Operating point 1 (lower velocity)

• M2.1 = 12%

• n2.1 = 500 rpm

} Operating point 2 (higher velocity)

• M2.2 = 39%

• n2.2 = 3000 rpm

Rdyn 1 1

1

39 % 12 %M 10,8 %
3000 min 500 min

1000 min

- -

-

-
= =

-

Fig. 6: Example: Calculate MRdyn

1

Rstat 1

3000 minM 39 % 10,8 % 39 % 32,4 % 6,6 %
1000 min

-
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Fig. 7: Example: Calculate MRstat
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5.7.2.3.2 Compensating for friction
Compensate for the static and dynamic friction of the axis by converting the previously determined
frictional torques from percentage values into the required unit and then entering them in the target
parameters.

ü You have determined the static frictional torque MRstat of the axis.

ü You have determined the dynamic frictional torque MRdyn of the axis.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in
the project menu > Parameter list area.

2. C09 Axis reference torque/force:
To convert the percentage values for the static and dynamic frictional torque of the axis into the
required unit for the target parameters, multiply the determined values by the load-side reference
value of the axis for percentage torque/force values.

3. Select the relevant drive controller in the project tree and click on the desired projected axis in
the Project menu > Wizard area.

4. Select the Drive Based Center Winder application wizard > Center winder > Compensation.

5. L110 Frictional torque static:
Define the frictional torque for the compensation for the static friction of the axis.

6. L120 Frictional torque dynamic:
Define the frictional torque for the compensation for the dynamic friction of the axis.
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5.7.2.3.3 Determining mass moments of inertia
To keep the material tensile force constant when the axis is accelerated, as an option, you can
compensate for the constant and variable mass inertia of the axis. To do so, determine the mass
moments of inertia of the axis in accordance with the respective component using the following
formulas for solid cylinders or hollow cylinders.

1J mr²
2

=

Fig. 8: Mass moment of inertia J (solid cylinder)

1 2r ² r ²J m
2
+

=

Fig. 9: Mass moment of inertia J (hollow cylinder)

Determining the mass moment of inertia of the gear unit
For the mass moment of inertia J2* of the gear unit, refer to the gear unit data (source: C29; target
parameter: L200).

Determining the mass moment of inertia of the shaft, including winder case
To calculate the mass moment of inertia J of the shaft including winder case, you need the following
values:

} Mass moment of inertia J of the shaft

• r: radius of the shaft

• m: weight of the shaft

} Mass moment of inertia J of the winder case

• r1: inner radius of the winder case

• r2: outer radius of the winder case

• m: weight of the winder case

Calculate the mass moment of inertia J of the shaft including winder case as follows:

1. Calculate the mass moment of inertia J of the shaft using the formula for solid cylinders.

2. Calculate the mass moment of inertia J of the winder case using the formula for hollow cylinders.

3. Add the mass moments of inertia J of the shaft and winder case and write down the result (target
parameter: L220).

Determining the mass moment of inertia of the winding
To calculate the mass moment of inertia J of the winding, you need the following values:

} Mass moment of inertia J of the winding

• r1: inner radius of winding

• r2: outer radius of winding at maximum winding diameter

• m: weight of winding at maximum winding diameter

Calculate the mass moment of inertia J of the winding using the formula for hollow cylinders and
wrote down the result (target parameter: L240).
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5.7.2.3.4 Compensating for mass inertia
To keep the material tensile force constant when the axis is accelerated, as an option, you can
compensate for the mass inertia of the axis by defining the previously determined mass moments of
inertia for the corresponding parameters or deactivate the function using the override.

ü You have determined the mass moment of inertia J2* of the gear unit.

ü You have determined the mass moment of inertia J of the shaft including winder case.

ü You have determined the mass moment of inertia J of the winding at maximum winding
diameter.

1. Select the Drive Based Center Winder application wizard > Center winder > Compensation.

2. L200 Mass moment of inertia gear unit:
Define the mass moment of inertia J of the gear unit for the compensation for the mass inertia of
the axis.

3. L220 Mass moment of inertia shaft:
Define the mass moment of inertia J of the shaft and winder case for the compensation for the
mass inertia of the axis.

4. L240 Mass moment of inertia winding:
Define the mass moment of inertia J of the material at maximum winding diameter for the
compensation for the mass inertia of the axis.

5. L301 Compensation mass moment of inertia override:
Define the override for the compensation for the mass moment of inertia of the axis or select the
value 0 to disable the function.
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5.7.2.4 Parameterizing the set material velocity
Parameterize the maximum permitted material velocity and override for the set velocity of the motor
and optionally define the time constant for the filter of the set material velocity.

1. Select the Drive Based Center Winder application wizard > Center winder > Set material
velocity.

2. L400 Source set material velocity:
Select the source of the set material velocity.

2.1. If a fieldbus is the source, select 4: Parameter L405.

3. L410 Material velocity maximum:
Define the maximum permitted material velocity.

4. L406 Set material velocity time constant:
If the quality of the signal requires it, adjust the time constant for the filter accordingly.

5. L07 Source velocity override:
Select the source of the velocity override for the set velocity of the motor.

5.1. To specify no velocity override, select 0: Inactive.

5.2. To specify a relative velocity override, select 1: Relative.

5.3. To specify an absolute velocity override, select 2: Absolute.

5.4. To specify the relative and absolute velocity override, select 3: Relative + absolute.

6. L05 Velocity override relative:
If you have selected 1: Relative or 3: Relative + absolute for L07, define the relative velocity
override.

7. L06 Velocity override absolute:
If you have selected 2: Absolute or 3: Relative + absolute for L07, define the absolute velocity
override.

Information

The velocity override is required to create a difference between the set velocity and
actual velocity of the motor so that the required actual material tensile force can be
applied for a consistent winding result.
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5.7.2.5 Parameterizing the actual material velocity
If the winding diameter is calculated by the drive controller, parameterize the diameter calculator as
described below.

1. Select the Drive Based Center Winder application wizard > Center winder > Actual material
velocity.

2. L652 Source actual material velocity:
Select the source of the actual material velocity.

2.1. If a fieldbus is the source, select 4: Parameter L650.

2.2. If the actual material velocity is equal to the set material velocity, select 
5: Parameter L420.

2.3. If a master encoder serves as the source for the actual material velocity, select 
6: Parameter G105.

3. L410 Material velocity maximum:
Define the maximum permitted material velocity.

4. L656 Actual material velocity time constant:
If the quality of the signal requires it, adjust the time constant for the filter accordingly.

Information

If the diameter calculator serves as the source for the winding diameter, the drive
controller calculates the winding diameter from the actual velocity of the axis and the
actual material velocity. Negative values for the actual material velocity are limited to
0.

Make sure that the actual material velocity is correctly parameterized so that the
winding diameter and consequently the set torque of the axis can be calculated
exactly for a consistent winding result.
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5.7.2.6 Parameterizing the set material tensile force
Parameterize the set material tensile force as described below.

Parameterizing the set material tensile force
Select the source and the mode for specifying the set material tensile force and optionally define the
time constant for the filter of the set material tensile force.

1. Select the Drive Based Center Winder application wizard > Center winder > Set material tensile
force.

2. L498 Source set material tensile force:
Select the source of the set material tensile force.

2.1. If a fieldbus is the source, select 4: Parameter L496.

3. L495 Set material tensile force time constant:
If the quality of the signal requires it, adjust the time constant for the filter accordingly.

4. L500 Set material tensile force mode:
Select the mode for specifying the set material tensile force.

4.1. If the set material tensile force is to be specified without changes, select 0: Direct set
material tensile force.

4.2. If the set material tensile force is to be increased in proportion to the diameter, select 
1: Set material tensile force proportional to diameter.

4.3. If the set torque of the motor is to be kept constant regardless of the diameter, select 
2: Constant torque.

4.4. If a diameter-dependent override is to be applied to the set material tensile force, select 
3: Characteristic.

ð The Set material tensile force: Curve wizard for parameterization of the diameter-dependent
set material tensile force override is displayed.

4.5. If the control word L150 of the center winder is the source for selecting the mode, select
4: Parameter L150.

Information

The required set torque for the axis is calculated from the specified set material
tensile force and winding diameter. Negative values for the set material tensile force
are limited to 0. For a consistent winding result, make sure that the set material
tensile force is correctly parameterized.

Set material tensile force: Parameterizing the curve
If you want to modify the specified set material tensile force using a diameter-dependent override,
define the value pairs of winding diameter and set material tensile force override.

ü You want to modify the set material tensile force with a diameter-dependent override 
(L500 = 3: Characteristic or 4: Parameter L150).

1. Select the Drive Based Center Winder application wizard > Center winder > Set material tensile
force > Set material tensile force: Curve.

2. L600 Set material tensile force curve diameter,
L610 Set material tensile force curve override:
Define the value pairs of winding diameter and set material tensile force override for the
diameter-dependent set material tensile force override.
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5.7.3 Parameterizing command operating mode
The following graphic shows the signal flows of the command operating mode. The elements shown
in a lighter shade are optional.

Controller

Motion
command

Motion
core

Continue
function

DI DI

Controller

AI

Controller

Controller

Start

Motion
variables

Motor

Start signal

Override

Alternative
sources

Fig. 10: Command operating mode: signal flows

In command operating mode, motion profiles are sent from a controller to the drive controller in the
form of motion tasks. A motion task includes a PLCopen-compliant motion command which defines
the basic motion method of the axis. The associated motion variables supply specifications on
velocity, acceleration, deceleration and jerk, from which the motion core of the drive controller
calculates the motion profile.

The controller coordinates the time progression and selects the motion tasks for the drive controller
that the positioning, velocity and torque/force commands process and run. In the controller, you
define the motion tasks. In the DS6, you parameterize the signal sources from which the drive
controller receives the motion tasks from the controller.

In command operating mode, drive controllers are either activated using a fieldbus or by a mixed
operation of a fieldbus and terminals.
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Proceed as follows ...
} Activate command operating mode.

} Parameterize the center winder.

• Parameterize the source of the winding diameter (calculator or sensor).

• Compensate for the friction and, optionally, the mass inertia of the axis.

• Parameterize the set material velocity and velocity override for the set velocity of the motor.

• Parameterize the actual material velocity.

• Parameterize the set material tensile force.

} Optional: Limit torque/force using the operating mode.

} Parameterize the command-specific motion variables.

} Define the source for the start signal.

} Optional: Define the source for the continue signal.

Information

The motion variables available for this operating mode that you configure in the
software depend on your application case as well as on additional project-specific
factors such as the use of a controller or the type of data transmission (fieldbus,
terminals).

5.7.3.1 Activating command operating mode
1. Select the relevant drive controller in the project tree and click on the desired projected axis in

the Project menu > Wizard area.

2. Select the Drive Based Center Winder application wizard.

3. Operating modes area:
Activate the Command operating mode option.

ð The corresponding wizards are displayed.
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5.7.3.2 Parameterizing the center winder
Parameterize the center winder as described below to be able to use the 30: MC_Winder motion
command for winding.

5.7.3.2.1 Parameterizing the diameter source
Parameterize the source of the winding diameter for the calculation of the material tensile force based
on whether a sensor serves as the source for the diameter in your drive project or whether the
diameter is calculated by the drive controller. First configure the general settings as described below,
then parameterize either the diameter sensor or the diameter calculator, depending on the source.

Parameterizing the diameter
Parameterize the minimum and maximum permitted winding diameters and optionally define the time
constant for the filter of the winding diameter.

1. Select the Drive Based Center Winder application wizard > Center winder > Diameter.

2. L03 Minimal diameter:
Define the minimum permitted diameter of the winding (usually corresponds to the winder case).

3. L04 Diameter maximum:
Define the maximum permitted diameter of the winding according to your application.

4. L111 Diameter time constant:
If the quality of the signal requires it, adjust the time constant for the filter accordingly.

Parameterizing the diameter source
Select either a sensor or the diameter calculator as the source for the winding diameter.

1. Select the Drive Based Center Winder application wizard > Center winder > Diameter >
Diameter determination.

2. L20 Source diameter:
Select the source for the winding diameter.

2.1. If the drive controller is to calculate the winding diameter, select 0: Diameter calculator.

2.2. If a sensor is the source for the winding diameter, select 1: Diameter sensor.

ð The parameters and wizards for parameterization of the winding diameter are displayed
according to the selected source.



Commissioning

Manual Drive Based Center Winder – PMC SC6, PMC SI6
1006912-en-US-02

Pilz | 62

Parameterizing the diameter limit
As an option, you can limit the winding direction or maximum permitted change in the winding
diameter per second.

1. Select the Drive Based Center Winder application wizard > Center winder > Diameter >
Diameter limit.

2. L35 Winding direction:
Define the winding direction.

2.1. If the winding diameter is allowed to both increase and decrease, select 0: Inactive.

2.2. If the winding diameter should only increase, select 1: Wind.

2.3. If the winding diameter should only decrease, select 2: Unwind.

2.4. If the control word of the center winder is the source for selecting the winding direction,
select 3: Parameter L150.

3. L36 Diameter change maximum:
Define the maximum permitted change in the winding diameter per second.

5.7.3.2.1.1 Parameterizing the diameter sensor
If a sensor serves as the source for the winding diameter, parameterize a fieldbus as the source.

ü The winding diameter is measured using a sensor (L20 = 1: Diameter sensor).

1. Select the Drive Based Center Winder application wizard > Center winder > Diameter >
Diameter determination.

2. L21 Source diameter sensor:
Select the source for the diameter sensor.

2.1. If a fieldbus is the source, select 4: Parameter L25.
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5.7.3.2.1.2 Parameterizing the diameter calculator
If the winding diameter is calculated by the drive controller, parameterize the diameter calculator as
described below.

Information

The winding diameter is required for a consistent calculation of the material tensile
force. When L20 = 0: Diameter calculator, it is calculated by the drive controller from
the actual velocity of the motor and actual material velocity, among other factors.
Accordingly, the winding diameter cannot be calculated when the axis is at a
standstill. This means that, depending on the actual winding diameter, a material
tensile force that is temporarily too low can result when continuing the 
30: MC_Winder motion command.

There are 2 options for enabling a consistent material tensile force when continuing
the 30: MC_Winder motion command from a standstill: You can either maintain the
calculated winding diameter during the axis standstill or temporarily specify a start
diameter via fieldbus when continuing the 30: MC_Winder motion command
(maintain diameter: L28; start diameter: L30).

Parameterizing the diameter calculator
Parameterize the minimum permitted velocity for the calculation of the winding diameter and
optionally the function for maintaining the diameter during a standstill via fieldbus.

ü The winding diameter is calculated by the drive controller (L20 = 0: Diameter calculator).

1. Select the Drive Based Center Winder application wizard > Center winder > Diameter >
Diameter determination.

2. L02 Velocity minimum:
Select the minimum permitted velocity to be used for calculating the winding diameter.

3. L28 Diameter hold:
If the center winder control word L150 is the source for maintaining the winding diameter, select
2: Parameter L150.
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Diameter calculator: Parameterizing the filter
If the quality of the signals requires it, as an option, you can define the velocity-dependent time
constant for the filter of the diameter calculator.

ü The winding diameter is calculated by the drive controller (L20 = 0: Diameter calculator).

1. Select the Drive Based Center Winder application wizard > Center winder > Diameter >
Diameter determination > Diameter calculator: Filter.

2. L80 Diameter calculator filter time constant, L81 Diameter calculator filter velocity:
To filter the actual material velocity, actual velocity of the axis and winding diameter calculated
from it, define the velocity-dependent time constants for the diameter calculator.

2.1. L80 Diameter calculator filter time constant:
If the quality of the signals requires it, define the time constants in L80[0] – [7] for the
respective velocity in L81[0] – [7].

2.2. L81 Diameter calculator filter velocity:
If the quality of the signals requires it, define the velocities in L81[0] – [7] for the
respective time constant in L80[0] – [7].

ð The velocity-dependent time constant for the calculation of the winding diameter is calculated
from the pairs of values for L80 and L81 (display: L82).

Diameter calculator: Parameterizing the start diameter
As an option, you can activate specification of a start diameter via fieldbus for the continuation of the
30: MC_Winder motion command from a standstill.

ü The winding diameter is calculated by the drive controller (L20 = 0: Diameter calculator).

1. Select the Drive Based Center Winder application wizard > Center winder > Diameter >
Diameter limit.

2. L30 Activate start diameter:
Activate specification of a start diameter via fieldbus.

2.1. If the control word of the center winder is the source for activating the start diameter,
select 2: Parameter L150.
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5.7.3.2.2 Compensating for friction and mass inertia
To enable a consistent winding result, the static and dynamic frictional torque of the axis must be
determined and compensated for. Parameterize compensation for the friction as described below.

As an option, the constant and variable mass moment of inertia of the axis can also be determined
and compensated for in order to keep the material tensile force constant the axis is accelerated.
Parameterize compensation for the mass inertia as described below or deactivate the function using
the corresponding override.

For more information on friction and mass inertia compensation, see Compensation for friction and
mass inertia [ 94].

5.7.3.2.2.1 Determining frictional torques
Determine the static and dynamic frictional torque using the jog control panel and the respective
formula as described below.

WARNING!

Injury to persons and material damage due to axis movement!

When you activate the control panel, DriveControlSuite gives you sole control of the
motions of the axis. If you are using a controller, it no longer monitors the axis
movements after the control panel is activated. The controller cannot intervene to
prevent collisions. The controller takes over control again when the control panel is
deactivated, which can cause unexpected axis movements.

▪ Do not switch to other windows when the control panel is active.

▪ Only use the control panel if you have visual contact with the axis.

▪ Make sure that no people or objects are within the travel range.

▪ For access via remote maintenance, there must be a communication link
between you and a person on site with eye contact to the axis.
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Jog control panel: Determining operating points
To determine the static and dynamic frictional torque, move the center winder without material using
the jog control panel at 2 different velocities and write down the pair of values of velocity and
associated torque for the 2 operating points.

ü There is an online connection between DriveControlSuite and the drive controller.

ü The winder case is empty; no material is wound up.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in
the Project menu > Wizard area.

2. Select the Jog control panel wizard.

3. Click Control panel on and then Enable.

ð The axis is monitored via the active control panel.

4. Check the default values of the control panel and adjust them to your projected axis model if
necessary.

5. I12 Jog velocity:
Define the lower velocity and move the axis according to the winding direction with Jog+ or Jog-.

6. I88 Actual speed, E02 Actual torque/force filtered:
Write down the absolute value of the actual velocity as well as the associated torque as
operating point 1 for the calculation of the frictional torques (n2.1, M2.1).

7. I12 Jog velocity:
Define the higher velocity and move the axis according to the winding direction with Jog+ or
Jog-.

8. I88 Actual speed, E02 Actual torque/force filtered:
Write down the absolute value of the actual velocity as well as the associated torque as
operating point 2 for the calculation of the frictional torques (n2.2, M2.2).

ð You have determined operating point 1 (n2.1, M2.1) and operating point 2 (n2.2, M2.2) for the
calculation of the frictional torques.
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Determining static and dynamic frictional torque
To calculate the static frictional torque MRstat and dynamic frictional torque MRdyn, you need the
following absolute values:

} Operating point 1 (lower velocity)

• M2.1: torque at the gear unit output

• n2.1: speed at the gear unit output

} Operating point 2 (higher velocity)

• M2.2: torque at the gear unit output

• n2.2: speed at the gear unit output

Use the following formula for the measured value pairs to determine the dynamic frictional torque
MRdyn and write down the result (target parameter: L120).

2, 2 2, 1
Rdyn

2, 2 2, 1

1

M MM
n n

1000 min-

-
=

-

Fig. 11: Dynamic frictional torque MRdyn

Use the following formula for the measured value pairs to determine the static frictional torque MRstat

and write down the result (target parameter: L110).

2, 2 2, 1
Rstat 2, 2 Rdyn 2, 1 Rdyn1 1

n nM M M M M
1000 min 1000 min- -
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Fig. 12: Static frictional torque MRstat

Example
} Operating point 1 (lower velocity)

• M2.1 = 12%

• n2.1 = 500 rpm

} Operating point 2 (higher velocity)

• M2.2 = 39%

• n2.2 = 3000 rpm

Rdyn 1 1

1

39 % 12 %M 10,8 %
3000 min 500 min

1000 min

- -

-

-
= =
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Fig. 13: Example: Calculate MRdyn
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Fig. 14: Example: Calculate MRstat
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5.7.3.2.2.2 Compensating for friction
Compensate for the static and dynamic friction of the axis by converting the previously determined
frictional torques from percentage values into the required unit and then entering them in the target
parameters.

ü You have determined the static frictional torque MRstat of the axis.

ü You have determined the dynamic frictional torque MRdyn of the axis.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in
the project menu > Parameter list area.

2. C09 Axis reference torque/force:
To convert the percentage values for the static and dynamic frictional torque of the axis into the
required unit for the target parameters, multiply the determined values by the load-side reference
value of the axis for percentage torque/force values.

3. Select the relevant drive controller in the project tree and click on the desired projected axis in
the Project menu > Wizard area.

4. Select the Drive Based Center Winder application wizard > Center winder > Compensation.

5. L110 Frictional torque static:
Define the frictional torque for the compensation for the static friction of the axis.

6. L120 Frictional torque dynamic:
Define the frictional torque for the compensation for the dynamic friction of the axis.
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5.7.3.2.2.3 Determining mass moments of inertia
To keep the material tensile force constant when the axis is accelerated, as an option, you can
compensate for the constant and variable mass inertia of the axis. To do so, determine the mass
moments of inertia of the axis in accordance with the respective component using the following
formulas for solid cylinders or hollow cylinders.

1J mr²
2

=

Fig. 15: Mass moment of inertia J (solid cylinder)

1 2r ² r ²J m
2
+

=

Fig. 16: Mass moment of inertia J (hollow cylinder)

Determining the mass moment of inertia of the gear unit
For the mass moment of inertia J2* of the gear unit, refer to the gear unit data (source: C29; target
parameter: L200).

Determining the mass moment of inertia of the shaft, including winder case
To calculate the mass moment of inertia J of the shaft including winder case, you need the following
values:

} Mass moment of inertia J of the shaft

• r: radius of the shaft

• m: weight of the shaft

} Mass moment of inertia J of the winder case

• r1: inner radius of the winder case

• r2: outer radius of the winder case

• m: weight of the winder case

Calculate the mass moment of inertia J of the shaft including winder case as follows:

1. Calculate the mass moment of inertia J of the shaft using the formula for solid cylinders.

2. Calculate the mass moment of inertia J of the winder case using the formula for hollow cylinders.

3. Add the mass moments of inertia J of the shaft and winder case and write down the result (target
parameter: L220).

Determining the mass moment of inertia of the winding
To calculate the mass moment of inertia J of the winding, you need the following values:

} Mass moment of inertia J of the winding

• r1: inner radius of winding

• r2: outer radius of winding at maximum winding diameter

• m: weight of winding at maximum winding diameter

Calculate the mass moment of inertia J of the winding using the formula for hollow cylinders and
wrote down the result (target parameter: L240).
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5.7.3.2.2.4 Compensating for mass inertia
To keep the material tensile force constant when the axis is accelerated, as an option, you can
compensate for the mass inertia of the axis by defining the previously determined mass moments of
inertia for the corresponding parameters or deactivate the function using the override.

ü You have determined the mass moment of inertia J2* of the gear unit.

ü You have determined the mass moment of inertia J of the shaft including winder case.

ü You have determined the mass moment of inertia J of the winding at maximum winding
diameter.

1. Select the Drive Based Center Winder application wizard > Center winder > Compensation.

2. L200 Mass moment of inertia gear unit:
Define the mass moment of inertia J of the gear unit for the compensation for the mass inertia of
the axis.

3. L220 Mass moment of inertia shaft:
Define the mass moment of inertia J of the shaft and winder case for the compensation for the
mass inertia of the axis.

4. L240 Mass moment of inertia winding:
Define the mass moment of inertia J of the material at maximum winding diameter for the
compensation for the mass inertia of the axis.

5. L301 Compensation mass moment of inertia override:
Define the override for the compensation for the mass moment of inertia of the axis or select the
value 0 to disable the function.
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5.7.3.2.3 Parameterizing the set material velocity
Parameterize the maximum permitted material velocity and override for the set velocity of the motor
and optionally define the time constant for the filter of the set material velocity.

1. Select the Drive Based Center Winder application wizard > Center winder > Set material
velocity.

2. L400 Source set material velocity:
Select the source of the set material velocity.

2.1. If a fieldbus is the source, select 4: Parameter L405.

3. L410 Material velocity maximum:
Define the maximum permitted material velocity.

4. L406 Set material velocity time constant:
If the quality of the signal requires it, adjust the time constant for the filter accordingly.

5. L07 Source velocity override:
Select the source of the velocity override for the set velocity of the motor.

5.1. To specify no velocity override, select 0: Inactive.

5.2. To specify a relative velocity override, select 1: Relative.

5.3. To specify an absolute velocity override, select 2: Absolute.

5.4. To specify the relative and absolute velocity override, select 3: Relative + absolute.

6. L05 Velocity override relative:
If you have selected 1: Relative or 3: Relative + absolute for L07, define the relative velocity
override.

7. L06 Velocity override absolute:
If you have selected 2: Absolute or 3: Relative + absolute for L07, define the absolute velocity
override.

Information

The velocity override is required to create a difference between the set velocity and
actual velocity of the motor so that the required actual material tensile force can be
applied for a consistent winding result.
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5.7.3.2.4 Parameterizing the actual material velocity
If the winding diameter is calculated by the drive controller, parameterize the diameter calculator as
described below.

1. Select the Drive Based Center Winder application wizard > Center winder > Actual material
velocity.

2. L652 Source actual material velocity:
Select the source of the actual material velocity.

2.1. If a fieldbus is the source, select 4: Parameter L650.

2.2. If the actual material velocity is equal to the set material velocity, select 
5: Parameter L420.

2.3. If a master encoder serves as the source for the actual material velocity, select 
6: Parameter G105.

3. L410 Material velocity maximum:
Define the maximum permitted material velocity.

4. L656 Actual material velocity time constant:
If the quality of the signal requires it, adjust the time constant for the filter accordingly.

Information

If the diameter calculator serves as the source for the winding diameter, the drive
controller calculates the winding diameter from the actual velocity of the axis and the
actual material velocity. Negative values for the actual material velocity are limited to
0.

Make sure that the actual material velocity is correctly parameterized so that the
winding diameter and consequently the set torque of the axis can be calculated
exactly for a consistent winding result.
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5.7.3.2.5 Parameterizing the set material tensile force
Parameterize the set material tensile force as described below.

Parameterizing the set material tensile force
Select the source and the mode for specifying the set material tensile force and optionally define the
time constant for the filter of the set material tensile force.

1. Select the Drive Based Center Winder application wizard > Center winder > Set material tensile
force.

2. L498 Source set material tensile force:
Select the source of the set material tensile force.

2.1. If a fieldbus is the source, select 4: Parameter L496.

3. L495 Set material tensile force time constant:
If the quality of the signal requires it, adjust the time constant for the filter accordingly.

4. L500 Set material tensile force mode:
Select the mode for specifying the set material tensile force.

4.1. If the set material tensile force is to be specified without changes, select 0: Direct set
material tensile force.

4.2. If the set material tensile force is to be increased in proportion to the diameter, select 
1: Set material tensile force proportional to diameter.

4.3. If the set torque of the motor is to be kept constant regardless of the diameter, select 
2: Constant torque.

4.4. If a diameter-dependent override is to be applied to the set material tensile force, select 
3: Characteristic.

ð The Set material tensile force: Curve wizard for parameterization of the diameter-dependent
set material tensile force override is displayed.

4.5. If the control word L150 of the center winder is the source for selecting the mode, select
4: Parameter L150.

Information

The required set torque for the axis is calculated from the specified set material
tensile force and winding diameter. Negative values for the set material tensile force
are limited to 0. For a consistent winding result, make sure that the set material
tensile force is correctly parameterized.

Set material tensile force: Parameterizing the curve
If you want to modify the specified set material tensile force using a diameter-dependent override,
define the value pairs of winding diameter and set material tensile force override.

ü You want to modify the set material tensile force with a diameter-dependent override 
(L500 = 3: Characteristic or 4: Parameter L150).

1. Select the Drive Based Center Winder application wizard > Center winder > Set material tensile
force > Set material tensile force: Curve.

2. L600 Set material tensile force curve diameter,
L610 Set material tensile force curve override:
Define the value pairs of winding diameter and set material tensile force override for the
diameter-dependent set material tensile force override.
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5.7.3.3 Limiting the torque/force using the operating mode
Define whether you also want to limit torque/force using the operating mode. Limiting using the
mechanical system takes place in the project configuration of the axis model. An additional limit using
the operating mode is optional.

1. Select the Drive Based Center Winder application wizard > Data sources > Torque/force limit:
Data source.

2. C132 Source maximum positiv T/F, C133 Source maximum negative T/F:
Select the source for the torque/force limit.

2.1. If the limiting values are transmitted over a fieldbus, select 4: Parameter C232 or 
4: Parameter C233.

3. If the limiting values are transmitted over a fieldbus, select Drive Based Center Winder
application > Command operating mode wizard.

4. J47 Maximum positive torque/force, J48 Maximum negative torque/force: 
Enter the maximum permitted positive and negative values for torque/force.

Information

The mechanical limit for torque/force is executed by C03 Maximum positive torque/
force and C05 Maximum negative torque/force using the axis model. The additional
limit using the operating mode is optional and refers to the values that you defined in
the axis model.
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5.7.3.4 Parameterizing command-specific motion variables
The parameters for the acceleration, deceleration and jerk motion variables are not included as
standard in the process data mapping. You can either store the values for the motion variables
permanently on the drive controller or add the corresponding parameters to the process data mapping
in order to receive the values from the controller.

Information

Before you start parameterizing the operating mode-specific motion variables,
parameterize the general motion variables and signal sources. If you obtain set
values for velocity, velocity override or torque/force for your drive project from
external sources, proceed as described in the chapter General motion variables and
signal sources [ 41].

5.7.3.4.1 Storing motion variables: Drive controller
If you want to store the specifications for acceleration, deceleration and jerk permanently on the drive
controller, check the default values in the Command operating mode wizard and, if necessary, adjust
them to your drive project.

ü You have activated command operating mode.

ü Parameters J44, J45 and J46 are not part of the process data mapping.

1. Select the Drive Based Center Winder application wizard > Command operating mode.

2. J44 Acceleration, J45 Deceleration, J46 Jerk:
Define the set values for acceleration, deceleration and jerk.

ð The specifications for acceleration, deceleration and jerk are permanently stored on the drive
controller.

Information

The parameters in the Command operating mode wizard are written by the controller
once there is an online connection between the drive controller and controller. In this
state, you can read off the values in the parameters that the drive controller receives
from the controller. Using parameter J41 Motion-ID, you can identify the ongoing
motion task in order to assign the status bit correctly.

5.7.3.4.2 Storing motion variables: Process data mapping
If you want to specify the settings for acceleration, deceleration and jerk via a controller, add the
required parameters to both the receive process data of the drive controller and the transmit process
data of the controller.

Information

When using double-axis controllers and axis-specific parameters, make sure that the
axis is addressed correctly (axis A: 1stCoordinate; axis B: 2ndCoordinate).
They can only access the parameters of their own axis.
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EtherCAT: Supplementing motion variables in PDO mapping
If you want to specify values for motion variables using a controller, supplement the desired
parameters in the receive process data of the drive controller.

ü You have activated command operating mode.

1. Select the EtherCAT wizard > Received process data RxPDO.

2. Coordinate column:
Enter the coordinate of the parameter that you want to apply to the process data mapping in the
Coordinate column.

2.1. If you want to obtain the values for acceleration from the controller, enter J44.

2.2. If you want to obtain the values for deceleration from the controller, enter J45.

2.3. If you want to obtain the values for jerk from the controller, enter J46.

ð The parameter is applied to the receive process data of the drive controller.
In the Name, Data type and Length columns, your information about the parameters is
displayed.

3. Add your changes to the process data mapping also to the transmit process data of the
controller.

PROFINET: Supplementing motion variables in PZD mapping
If you want to specify values for motion variables using a controller, supplement the desired
parameters in the receive process data of the drive controller.

ü You have activated command operating mode.

1. Select the PROFINET wizard > Received process data RxPZD.

2. Coordinate column:
Enter the coordinate of the parameter that you want to apply to the process data mapping in the
Coordinate column.

2.1. If you want to obtain the values for acceleration from the controller, enter J44.

2.2. If you want to obtain the values for deceleration from the controller, enter J45.

2.3. If you want to obtain the values for jerk from the controller, enter J46.

ð The parameter is applied to the receive process data of the drive controller.
In the Name, Data type and Length columns, your information about the parameters is
displayed.

3. Add your changes to the process data mapping also to the transmit process data of the
controller.
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5.7.3.5 Parameterizing the start signal
Define the source for the execute signal in order to start a motion command selected in J40 in
command operating mode.

1. Select the Drive Based Center Winder application > Data sources > Application digital signals:
Data source.

2. I100 Source execute:

2.1. If a digital input (direct or inverted) acts as the source, select the corresponding input.

2.2. If the control word I210 of the application acts as the source, select 2: Parameter.

ð Bit 0 of the control word is set as the data source.

5.7.3.6 Parameterizing the continue signal
To use the continue function to resume an interrupted movement command, configure the source of
the continue signal. If you do not use the continue function, select a new command using J40 and
start it using the start signal (execute).

You can find more information on the continue function, continuable motion commands and reasons
for canceling under Continue function [ 141].

1. Select the Drive Based Center Winder application > Command operating mode > Operating
mode digital signals: Data source.

2. J38 Source continue:
To use the continue function to resume interrupted motion commands, select the source for the
continue signal.

2.1. If a digital input (direct or inverted) acts as the source, select the corresponding input.

2.2. If the control byte J37 for the command operating mode acts as the source, select 
2: Parameter.

ð Bit 0 of the control byte is set as the source.
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6 More on Drive Based Center Winder?
The following chapters summarize the important terms, modules and relationships concerning Drive
Based Center Winder.

6.1 Drive Based Center Winder – Concept
Applications such as Drive Based Center Winder, which calculate and adjust the motions in the drive
itself, are referred to as drive-based systems. They are either networked via a fieldbus or obtain
signals and set values using analog and digital hardware inputs.

The Drive Based Center Winder application provides you with a standard set of motion commands
based on PLCopen, which is supplemented by your own motion commands and thus offers flexible
drive-based motion control for the position, velocity and torque/force control types.

The motion commands are combined into corresponding operating modes for different applications.
Depending on the selected operating mode, the motion variables required for parameterizing
individual motion profiles, such as set or limit values, are recorded.

Based on all parameterized data, the motion core finally calculates an individual motion profile.
Specified set values are transmitted to the control cascade, which in turn activates the motor.

Additional wizards such as control panels or jog mode help with commissioning and the configuration
test or are designed for emergency operation.

The following graphic shows the components and configuration steps for the Drive Based Center
Winder application. The elements shown in a lighter shade are optional.
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Fig. 17: Components and configuration steps

6.1.1 Operating modes
The operating modes of the Drive Based Center Winder application involve command sets bundled
by application for configuring individual motion profiles for production operation.

Thanks to flexible, user-defined adjustment options for the operating modes, the Drive Based Center
Winder application offers a compact – yet extremely variable – scope of functions that is suitable for a
wide range of application cases in drive technology. After selecting the suitable operating mode for
the respective application case, users concentrate just on parameterizing the most important
sequences for their application.

Note that a drive controller can only process one operating mode per axis.
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6.1.1.1 Center winder
Center winder operating mode is reduced to the 30: MC_Winder motion command, which is essential
for winding. It is used to calculate the set values for the center winder according to the selected
control method.

The set and actual values for motion variables, such as the material tensile force or material velocity,
can be taken into account either by a controller via fieldbus or via the analog inputs, depending on the
drive controller series.

Typical application examples are winding applications such as winding, unwinding or rewinding
materials such as plastic, wire, textiles or paper.

6.1.1.2 Command
Command operating mode enables a drive controller to run parameterizable motions. In this process,
a range of motion commands are processed that correspond to the behavior of the motion control
blocks of the PLCopen standard.

A controller coordinates the time sequences by selecting motion commands based on PLCopen, such
as MC_MoveAbsolute (move to absolute set position) or MC_MoveRelative (move relative to actual
position).

Parameters such as set position, velocity or torque limit can be defined individually.

Typical application examples are individual axis movements that are communicated by a controller
(PLC) to the drive controller.

6.1.2 Jog mode
For commissioning, emergency operation and maintenance or repair work, the manufacturer-specific
jog mode (manual movement) is available. Using jog mode, you can move the drive independently of
the controller, for example.

You can use jog mode either through the jog control panel or a controller that applies the manual
movement.



More on Drive Based Center Winder?

Manual Drive Based Center Winder – PMC SC6, PMC SI6
1006912-en-US-02

Pilz | 81

6.1.3 Control panels
The control panels are special wizards in DriveControlSuite, which you can use to take control of the
axis. With the help of the control panels, you can manually release and move an axis even if the drive
controller has no operating unit or is difficult to access.

Using control panels, you can check the connection wiring, the project configuration of your physical
axis model or the parameterization of your application in the respective operating mode before you
switch to normal operation.

The following control panels are available:

} Jog control panel is used to check the projected axis model in jog mode.

} Control panel motion provides you with a standard set of motion commands based on PLCopen.
Via the control panel, independent of the application and fieldbus interface, you can parameterize
a motion profile directly for the motion core of the axis in order to check the basic functions of the
drive controller.

Because control panels override normal operation, they can be activated only with a deactivated
enable signal and should be operated by experienced users only.

6.1.4 Motion core
Based on the projected and parameterized data, the motion core calculates a motion profile and
associated detail movements as a basis for the drive controller as well as mandatory set values for
the control cascade.

6.1.5 Data sources
The signals that activate a drive controller can be obtained from different data sources. 
Each of the possible operating modes has a set of set values that is permanently stored in the
software. Furthermore, signals exist for the motion start or motion limits or velocity specifications that
generally come from external data sources.

A fieldbus commonly acts as the signal source, though analog or digital hardware inputs or even a
mixed operation made up of the above-listed data sources are also possible.

Values that are obtained from external data sources are usually adapted to the stored reference
values automatically, i.e. calibrated and calculated with scaling.
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6.1.6 Additional functions
Each of the available operating modes can be expanded by drive-based additional functions. For
example, these offer convenient monitoring of process variables such as position, velocity or torque/
force (cams, comparators) or control of external process variables (PID controller).

6.1.6.1 Additional counter function
The additional counter function in Drive Based type applications provides you with up to 4
independent counters with which you can implement smaller automation tasks directly in the drive
controller, such as direct or indirect control of the digital outputs.

Function
For each counter, you define a comparison value, a digital signal for increasing the counter reading
and a digital signal for resetting the counter reading (comparison value: N41; increase source: N43;
reset source: N46). With each rising edge of the counter signal, the counter reading is increased by 1
until the comparison value is reached (counter reading: N44). When the comparison value is reached,
a status signal is issued and further counter signals are ignored until the counter reading is reset or
the comparison value is increased (status: N42).

Signals

Counter reading

3 = Comparison value
2
1
0

Reset

Counting

t

t

t

Fig. 18: Additional counter function: Example

The digital inputs of the drive controller (direct or inverted), parameters with the BOOL data type or
individual bits of parameters with the BYTE, WORD or DWORD data type (example bit addressing:
E49.4 for Switch on inhibit reason = STO) can serve as the source for the signals for increasing and
resetting the counter status. The reset signal has priority and is executed immediately; as long as it is
active, the counter reading remains at 0 and rising edges to increase the counter reading are ignored.
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6.1.6.1.1 Parameterizing counters
To parameterize the additional counter function, proceed as described below.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in
the Project menu > Wizard area.

2. Select the Drive Based Center Winder application wizard > Additional functions.

3. Activate the Counter option.

ð The additional function is activated and the associated wizards and parameters are
displayed.

4. Select the Drive Based Center Winder application wizard > Additional functions > Counters.

5. Number:
Select the desired counter and activate it using the corresponding option.

ð The associated parameters are displayed.

6. N41 Counter comparison value:
Define the comparison value.

7. N43 Source counter:
Select the source for the signal that increases the counter reading by 1 until the comparison
value is reached.

7.1. If a parameter is the source, select 2: Parameter.

7.2. If a digital input (direct or inverted) acts as the source, select the corresponding input.

8. N45 Counter indirect reading:
If a parameter is used as the source for increasing the counter, define the desired coordinate, if
necessary with bit addressing.

9. N46 Source reset counter reading:
Select the source for the signal that resets the counter reading to 0.

9.1. If a parameter is the source, select 2: Parameter.

9.2. If a digital input (direct or inverted) acts as the source, select the corresponding input.

10. N47 Reset counter reading via parameter:
If a parameter is used as the source for resetting the counter, define the desired coordinate, if
necessary with bit addressing.
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6.1.6.1.2 Parameterizing counters: Examples
For example, you can use the additional counter function to control the digital outputs directly or
indirectly (using the additional INT32 comparator function) by reaching the comparison value.

Controlling a digital output directly
To control a digital output directly via the counter, you can use the status of the counter as a source.

1. Activate the additional counter function.

2. Select the Counters wizard.

3. Parameterize the counter according to your application case.

4. Select the status of the counter as the source for the desired digital output 
(e.g. DO1: F61 = N42).

ð The digital output is controlled directly via the status of the counter.

Controlling a digital output indirectly (INT32 comparator)
To indirectly control a digital output, you can use the additional counter and INT32 comparator
functions in combination with each other. If you use the INT32 comparator to check whether the
current counter reading fulfills a certain condition, you can control a digital output depending on the
result of the comparator.

1. Activate the additional counter and comparator functions.

2. Select the Counters wizard.

3. Parameterize the counter according to your application case.

4. Select the INT32 comparators wizard.

5. Parameterize the INT32 comparator according to your application case.

5.1. C78 Source INT32 comparator:
Select the counter reading N44 as the source for the INT32 comparator.

6. Select the result of the INT32 comparator as the source for the desired digital output 
(e.g. DO1: F61 = C83).

ð The digital output is controlled indirectly via the counter reading.
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6.1.6.2 Additional motor potentiometer function
In Drive Based Center Winder type applications, the additional motor potentiometer (MOP) function
provides you with the option of adjusting an electromechanical potentiometer, such as for set value
specification or for indirect control of the digital outputs.

Function
The motor potentiometer can be adjusted continuously via digital up and down signals, for example
for specifying set values for axis movements via the output value (output value: G373). The output
value can be limited by a maximum positive and a maximum negative value (limit: G362, G363; limit
value reached: G374). Either the digital inputs of the drive controller or the graphical programming
can serve as the source for the up and down signals (source: G364, G365). The initialization signal
has priority over the up and down signals and is executed immediately; the initialization value is freely
definable (source: G369; value: G366).
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Fig. 19: Motor potentiometer: Linear and stepwise calculation

You can use the operating mode of the motor potentiometer to influence both the calculation of the
output value and the storage behavior (operating mode: G368). The output value is calculated either
linearly or in steps and can be saved either with an active enable signal, prior to the next restart of the
drive controller or in non-volatile memory. The parameterized ramp (ramp: G361) applies to both the
linear and stepwise calculations. With a linear calculation, the output value is changed for the duration
of the incoming up or down signal. With a stepwise calculation, the output value is changed by the
parameterized increment at signal input (increment: G367). If another up or down signal is received
while the set value has not yet been reached, it is adjusted by the corresponding increment. If the up
and down signals are active at the same time, the output value remains unchanged in both operating
modes.
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6.1.6.2.1 Parameterizing motor potentiometers
To parameterize the additional motor potentiometer function, proceed as described below.

1. Select the relevant drive controller in the project tree and click on the desired projected axis in
the Project menu > Wizard area.

2. Select the Drive Based Center Winder application wizard > Additional functions.

3. Activate the Motor potentiometer option.

ð The additional function is activated and the associated wizards and parameters are
displayed.

4. Select the Drive Based Center Winder application wizard > Additional functions > Motor
potentiometer.

5. G361 Motor potentiometer ramp:
Define the ramp for calculating the output value.

6. G362 Motor potentiometer positive maximum value, G363 Motor potentiometer negative
maximum value:
Define the maximum permissible positive and negative output values of the motor potentiometer.

7. G364 Source motor potentiometer up, G365 Source motor potentiometer down:
Select the sources for the up and down signals of the motor potentiometer.

7.1. If the graphical programming is used as the source, select 2: Parameter.

7.2. If a digital input (direct or inverted) acts as the source, select the corresponding input.

8. G368 Motor potentiometer operating mode:
Select the desired operating mode for the motor potentiometer.

8.1. To calculate the output value of the motor potentiometer linearly, select 0: Linear, 
2: Linear (remanent) or 4: Linear (enable-dependent), depending on the desired storage
behavior.

8.2. To calculate the output value of the motor potentiometer in steps, select 1: Step-by-step,
3: Step-by-step (remanent) or 5: Step-by-step (enable-dependent), depending on the
desired storage behavior.

9. G367 Motor potentiometer increment:
If you calculate the output value of the motor potentiometer in steps, define the desired
increment.

10. G366 Motor potentiometer initialization value:
Optionally define the desired initialization value.

11. G369 Source motor potentiometer initialization:
Select the source for the initialization signal of the motor potentiometer.
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6.1.6.2.2 Parameterizing motor potentiometers: Examples
For example, you can use the additional motor potentiometer function to specify set values for the
velocity, velocity override or torque/force and thus control the axis directly in local operation, e.g.
during commissioning, if the controller fails or if the machine has no controller at all. Using the motor
potentiometer, you can also control the analog outputs directly or the digital outputs indirectly (using
the additional REAL32 comparator function).

Information

In Drive Based Center Winder applications, you can use the motor potentiometer to
control analog and digital outputs as well as for set value specification in command
operating mode if you are using 4: MC_MoveVelocity, 8: MC_MoveSpeed or 
9: MC_TorqueControl as the motion command. When using the 30: MC_Winder
motion command, the set value specification for the set material velocity L405 or for
the associated override L07 is not provided using the motor potentiometer.

Controlling a digital output indirectly (REAL32 comparator)
To indirectly control a digital output, you can use the additional motor potentiometer and INT32
comparator functions in combination with each other. If you use the REAL32 comparator to check
whether the output value of the motor potentiometer fulfills a certain condition, you can control a
digital output depending on the result of the comparator.

1. Activate the additional motor potentiometer and REAL32 comparator functions.

2. Select the Motor potentiometer wizard.

3. Parameterize the motor potentiometer according to your application case.

4. Select the REAL32 comparators wizard.

5. Parameterize the REAL32 comparator according to your application case.

5.1. C65 Source REAL32 comparator:
Select the output value of the motor potentiometer G373 as the source for the REAL32
comparator.

6. Select the result of the REAL32 comparator as the source for the desired digital output 
(e.g. DO1: F61 = C75).

ð The digital output is controlled indirectly via the motor potentiometer.
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Specifying a set velocity (external velocity)
To specify a set velocity via the motor potentiometer, select its output value as the source for the
external velocity and use this as the set value source for the motion command.

1. Activate the additional motor potentiometer function.

2. Select the Motor potentiometer wizard.

3. Parameterize the motor potentiometer according to your application case.

4. Select the External velocity: Data source wizard.

5. G461 Source external velocity: 
Select 5: Indirect read parameter G811.

6. G811 Indirect read external velocity:
Select the output value of the motor potentiometer G373 as the source for the external velocity.

ð The output value of the motor potentiometer serves as the source for the external velocity.

ð The external velocity can be provided as a set value specification by accessing parameter
G462.

7. For the command operating mode, parameterize the motion command and set value source via
parameters J40 and J52.

7.1. J40 Command:
Select the motion command 4: MC_MoveVelocity or 8: MC_MoveSpeed.

7.2. J52 Source velocity 1:
Select 1: Parameter G462 as the source for the external velocity.

ð The output value of the motor potentiometer serves as the set value specification; the conversion
to a set velocity is carried out using maximum permissible speed I10.
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Specifying a set velocity (external additional velocity)
To additionally regulate the set velocity via the motor potentiometer, select its output value as the
source for the external additional velocity and use this as the set value source for the motion
command.

ü You are using command operating mode or velocity, torque/force operating mode.

1. Activate the additional motor potentiometer function.

2. Select the Motor potentiometer wizard.

3. Parameterize the motor potentiometer according to your application case.

4. Select the External additional velocity: Data source wizard.

5. G464 Source external additional velocity: 
Select 5: Indirect read parameter G811.

6. G812 Indirect read additional external velocity:
Select the output value of the motor potentiometer G373 as the source for the external additional
velocity.

ð The output value of the motor potentiometer serves as the source for the external additional
velocity.

ð The external velocity can be provided as a set value specification by accessing parameter
G465.

7. For the command operating mode, parameterize the motion command and set value source via
parameters J40 and J54.

7.1. J40 Command:
Select the motion command 4: MC_MoveVelocity or 8: MC_MoveSpeed.

7.2. J54 Source velocity 2:
Select 1: Parameter G465 as the source for the external additional velocity.

ð The output value of the motor potentiometer serves as the set value specification; the conversion
to a set velocity is carried out using maximum permissible speed I10.
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Specifying the velocity override
To specify a velocity override via the motor potentiometer, select its output value as the set value
source and apply the velocity override to the motion command.

1. Activate the additional motor potentiometer function.

2. Select the Motor potentiometer wizard.

3. Parameterize the motor potentiometer according to your application case.

4. Select the Velocity override: Data source wizard.

5. G467 Source velocity override: 
Select 5: Indirect read parameter G813.

6. G813 Indirect read velocity override:
Select the output value of the motor potentiometer G373 as the source for the velocity override.

ð The output value of the motor potentiometer serves as the source for the velocity override.

ð The velocity override can be provided as a set value specification by accessing parameter
G468.

7. For the command operating mode, parameterize the motion command and set value source via
parameters J40 and J51.

7.1. J40 Command:
Select the motion command 4: MC_MoveVelocity or 8: MC_MoveSpeed.

7.2. J51 Source velocity override:
Select 1: Parameter G468 as the source for the velocity override.

ð The output value of the motor potentiometer is used as the set value specification for the velocity
override.
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Specifying the set torque/set force
To specify a set torque/force via the motor potentiometer, select its output value as the set value
source for the motion command.

1. Activate the additional motor potentiometer function.

2. Select the Motor potentiometer wizard.

3. Parameterize the motor potentiometer according to your application case.

4. Select the Set torque/force, velocity bracketing: Data source wizard.

5. G470 Source torque/force reference: 
Select 5: Indirect read parameter G814.

6. G814 Indirect read torque/force reference:
Select the output value of the motor potentiometer G373 as the source for the set torque/force.

ð The output value of the motor potentiometer serves as the source for the set torque/force.

ð The set torque/force can be provided as a set value specification by accessing parameter
G471.

7. For the command operating mode, parameterize the motion command and set value source via
parameter J40.

7.1. J40 Command:
Select the 9: MC_TorqueControl motion command.

ð The parameterized set value source is applied automatically; no further settings are
necessary.

ð The output value of the motor potentiometer serves as the set value specification for the set
torque/force.
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6.2 Center winder – Concept
A system that allows winding, unwinding or rewinding of materials such as plastic, wire, textiles or
paper is called a winder. There are various winding processes for implementing winding applications.
In the center winder, the winding is driven by a central shaft with an attached winder case onto which
material is wound or from which material is unwound.

M MM M M

Surface winder Center winder (surface winder) Center winder (gap winder)

Fig. 20: Center winder: Types

Center winder: Basic terms
When material is wound or unwound, the diameter of the winding changes. The winding diameter
must be measured by a sensor or calculated by the drive to keep the actual material tensile force
constant. If a sensor is not used, the drive controller calculates the winding diameter from the material
velocity (specifically: from the actual material velocity).

Winding method: Tensile force control (indirect tensile force control)

M

M

Material velocity
Material tensile force

Torque
Speed

Winding diameter

Fig. 21: Structure: Center winder with tensile force control

In the case of tensile force control of the center winder (indirect tensile force control), the set material
tensile force is specified and the set speed of the axis is calculated according to the winding diameter
and the specified set material velocity. The material tensile force can also be modified, for example,
with the aid of a diameter-dependent override (winding hardness curve).

In order to achieve a consistent winding result, the static and dynamic friction of the axis must also be
taken into account and compensated for. Compensation for the constant as well as variable mass
inertia of the axis is optional.
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Diameter Compensation

Diameter
calculator

Diameter
sensor Frictional torque

Mass moment of
inertia

L420 Set material
velocity

L05, L06, L07 Override L102 Set velocity

L500 Set material
tensile force mode

L103
Set torque

L510 Set material tensile
force modified

L499 Set material
tensile force

Motion
coreL29

Diameter

Fig. 22: Block diagram: Center winder with tensile force control
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6.2.1 Compensation for friction and mass inertia
To enable a uniform winding result, the static and dynamic friction of the axis must be determined and
compensated for. Compensation for constant and variable mass inertia is optional and enables
constant material tensile force when the axis is accelerated.

Static and dynamic frictional torque

L110

L120

200010000

Fr
ic

tio
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l t
or

qu
e 

in
 N

Speed in rpm

Fig. 23: Center winder: frictional torque of the axis

The frictional torque MR corresponds to the torque that the drive must provide to compensate for the
friction of the axis. The static frictional torque MRstat must be provided by the drive in order to set the
axis in motion from a standstill. The dynamic frictional torque MRdyn must be provided by the drive in
order to keep the axis in motion (static frictional torque: L110; dynamic frictional torque: L120).

Constant and variable mass moment of inertia

L200

L240

L220 n1
n2

Fig. 24: Center winder: mass moment of inertia of the axis

The mass moment of inertia J and the angular acceleration α result in the torque that the drive must
provide to set the axis in rotary motion.

The constant mass moment of inertia results from the sum of the mass moments of inertia of the
motor, gear unit and shaft with winder case (motor: B62; gear unit: L200; shaft + winder case: L220).

The variable mass moment of inertia results from the mass moment of inertia of the material
depending on the current winding diameter (winding: L240; diameter source: L20).

The mass moment of inertia of the axis results from the constant and variable mass moments of
inertia (display: L320).
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6.3 Axis model
With the help of the axis model, you map the real mechanical environment of your drive project in
DriveControlSuite by parameterizing the axis type and the arrangement of existing encoders. The
parameterization of the axis model is required for the smooth operation and easy diagnosis of your
drive train.

With I05 Type of axis, you select a rotational or a translational axis model and define whether the
scaling of the axis is done using either predefined or individually configured units of measure. With
I00 Position range, you parameterize either an endless or a limited travel range. You parameterize
the encoder arrangement by using B26 Motor encoder and I02 Position encoder.

The 6th generation of Pilz drive controllers are specially developed for communication between the
drive controller and controller on the basis of the actual variables at the output (° or mm of real axis
movement). The scaling of the axis model is calculated by the drive controller's firmware
independently of the encoder model, without any rounding errors or drift.

If your axis model is not followed by any other gear ratios, you can operate the axis with output-side
motion variables where all nominal and actual values correspond to the real axis movement.

Information

The firmware processes values for the motion variables velocity, acceleration and
jerk in the data type REAL32 (floating-point number, 32 bits). Position values are
processed in the INT32 data type (integer, 32 bits) to eliminate rounding errors and
enable precise movements.

Abbreviation Meaning

M Motor

MEnc Motor Encoder

PEnc Position Encoder

Rotational axis models
The following figures each show a rotational axis model consisting of a motor, a gear unit and a rotary
table (endless rotational) or a pointer (limited rotational). Rotational axis models support rotational
motor encoders as well as rotational position encoders.

n
n

1

2

MEnc Gear PEnc

M

Fig. 25: Endless-rotational motion: Rotary table

M

MEnc PEncGear

n
n

1

2

Fig. 26: Limited-rotational motion: Pointer
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Translational axis models
The following figures each show a translational axis model consisting of a motor, gear unit, feed and
conveyor belt (endless translational) or tool slide (limited translational). Translational axis models
support rotational motor encoders as well as rotational or translational position encoders.

MEnc

n
n

1

2

Gear PEnc Feed

M

PEnc

n
x

Fig. 27: Endless translational motion: Conveyor belt

M

MEnc Gear

n
n

1

2

PEnc Feed

PEnc

n
x

Fig. 28: Limited translational motion: Tool slide

Translational axis model: Linear motor
The following figure shows a limited translation axis model using the example of a linear motor. Linear
motors only support translational motor encoders and translational position encoders.

MEnc/PEnc

LinM

Fig. 29: Limited translational motion: Linear motor
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Encoder arrangement
You parameterize the encoder arrangement by using B26 Motor encoder and I02 Position encoder.
The motor encoder for velocity control is located on the motor shaft. The position encoder for position
control is located on the gear unit output. If you use only one of the two encoders, it will be used for
both velocity and position control.

Encoder Parameterization Encoder arrangement

Motor encoder B26 ≠ 0: Inactive

I02 = 0: Motor encoder
MEnc

n
n

1

2

Gear unit PEnc

M

Position encoder B26 ≠ 0: Inactive

I02 = B26
MEnc

n
n

1

2

Gear unit PEnc

M

Motor encoder &
position encoder

B26 ≠ 0: Inactive

I02 ≠ B26
MEnc

n
n

1

2

Gear unit PEnc

M
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6.4 Limit switches
Limit switches are sensors that detect when a certain position has been reached.

A distinction is made here between hardware limit switches and software limit switches. While a
hardware limit switch is a real switch (hardware), a software limit switch refers to the position limiting
or position monitoring implemented in the software.

There are hardware and software limit switches on real axes, while virtual masters only have software
limit switches.

Behavior in jog mode, reaching the +/- 31 bit computing limit and simultaneous triggering of positive
and negative limit switches are special cases.

6.4.1 Real axes
There are hardware and software limit switches on real axes.

6.4.1.1 Faults
If a hardware limit switch is overshot, a fault is triggered immediately.

If a software limit switch is overshot, a fault is triggered if the following applies:

} For a positive software limit switch: actual position > limit switch position + I22

} For a negative software limit switch: actual position < limit switch position + I22

Faults
53: Limit switch

Causes
} 1: Hardware-Limit-Switch positive

} 2: Hardware-Limit-Switch negative

} 3: SW-limit switch positive

} 4: SW-limit switch negative

} 5: +/- 31 bit computing limit reached

} 6: Linear motor moving range

} 7: Both limit switches not connected

The fault can be acknowledged. Note that movement is only possible in the opposite direction of the
limit switch, since the direction of the triggered hardware or software limit switch is locked. A direction
lock is displayed in parameter I196.

A fault can be triggered again when the direction lock is no longer active.
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6.4.1.2 Denial
If the axis is at a hardware limit switch (I441 or I442 = High) or if it is beyond of the software limit
switch, movement is denied in the locked direction.

A direction lock is displayed in parameter I196. The direction lock is deactivated if the following
applies:

} For a positive software limit switch: actual position < limit switch position − I22

} For a negative software limit switch: actual position > limit switch position + I22

When the direction lock is active, parameter I91 Error = 1: Active.

The cause is output in parameter I90.

Possible causes are:

} 1: Illegal direction

} 2: SW-limit switch positive

} 3: SW-limit switch negative

} 10: Denied because position is not in circular length

} 11: HW-limit switch positive

} 12: HW-limit switch negative

Information

There are no software limit switches for an infinite axis, since this would contradict
the nature of an infinite axis.

A movement limitation is also displayed in parameter E80:

} If E80 = 20: Limit switch, check the parameterization and the connection of the limit switches.

} If E80 = 15: Illegal direction, check the set values and a possible direction lock in parameter I196.

Also check I196 if the permitted direction was limited with I04.

Information

Parameter I04 is only available for infinite axes.
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6.4.1.3 Hardware limit switches
Hardware limit switches apply if your sources are defined in parameters I101 and I102.

Relevant parameters
} I101 Source positive /limit switch

} I102 Source negative /limit switch

} I441 Signal /HW limit switch positive

} I442 Signal /HW limit switch negative

} I805 Actual value HW-Limit switch positive

} I806 Actual value HW-Limit switch negative

} I52 Delete limit switch memory

} I196 Direction blocking

If I441 and I442 = 0: Inactive, fault 53 is triggered with cause 7: Both limit switches not connected.
Therefore, after parameterizing I101 and I102, check whether the hardware limit switches are also
connected physically.

If I101 and I102 = 2: Parameter, the fault is triggered by the control word of the application (I210). In
this case, check the controller connection.

Passable hardware limit switches
The hardware limit switches can be passed over. It is therefore possible to use an infinite cam as a
hardware limit switch. The limit switch is detected if the signal goes to 0: Inactive (parameters I441
and I442).

If the hardware limit switch is overshot, the position at which the limit switch was detected is saved.
When resetting limit switches, the axis must have reached or passed back over this saved position
before the signal is valid again.

1

4

3

2

Neg. hardware limit switch

Negative Positive
Axis reference system

Neg. hardware limit switch memory

Pos. hardware limit switch

Pos. hardware limit switch memory

I442

I806

I441

I805

Fig. 30: Hardware limit switch memory

1 Setting the memory (negative hardware limit switch) with rising edge
2 Resetting the memory (negative hardware limit switch) with falling edge
3 Setting the memory (positive hardware limit switch) with rising edge
4 Resetting the memory (positive hardware limit switch) with falling edge
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Information

The passable hardware limit switch is no longer effective once the position at which
the edge of the limit switch was detected has been passed over again.

Note that the positions are not saved in non-volatile memory. This means that if the axis is beyond a
passable limit switch after activation, it must first be reset to the regular travel range.

The entire system is simpler if you do not use any passable limit switches.

During commissioning or in case of defective hardware limit switch connections, problems can arise
with the saved positions. These can be deleted with parameter I52. However, deletion only takes
place if the corresponding limit switch signal is inactive. Stored positions can also be deleted by
referencing, setting a reference can be deleted using I452 or by restarting the drive controller.

During referencing, the hardware limit switches are not evaluated as limit switches. There are
referencing methods in which the hardware limit switches are used for referencing.

Example

A positive limit switch ranges from position 100 to 120.
When moving in the positive direction, it is detected at 100.
On the return journey, due to tolerances, it can be the case that the limit switch has already been left
at 101.
Despite this, position 100 must be undershot in order to leave the effective limit switch.

6.4.1.4 Hardware limit switches when referencing
Hardware limit switches assume a special position when referencing.

Limit switch as reference switch
The hardware limit switches can be used in place of a reference switch (I30 = 2: Limit switch).

Change of direction
In other referencing types, a hardware limit switch signal leads to a change of direction. However, the
signal only causes a change if it matches the direction of travel.

If the detected hardware limit switch does not match the direction of travel (e.g. negative limit switch
with positive direction of travel), a fault is then triggered.

Example

At the start of referencing, the axis is between the reference switch and positive limit switch. The
referencing direction is positive. The axis moves in the positive direction and first encounters the
positive limit switch, not the reference switch. The axis reverses and searches for the reference
switch in the other direction.
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6.4.1.5 Software limit switches
Software limit switches only apply if the axis has been referenced.

Only limited axes have software limit switches (I00 = 0: Limited).

Relevant parameters
} I50 Software stop positive

} I51 Software stop negative

} I196 Direction blocking

If the values defined in parameter I50 and parameter I51 are the same, the software limit switches are
deactivated.

6.4.1.6 Software limit switches when referencing
Software limit switches are not evaluated when referencing.

6.4.1.7 Shutting down by the limit switch
If a hardware limit switch is approached from the permitted travel range, a fault is immediately
triggered after detecting the limit switch edge.

If a software limit switch is approached from the permissible travel range, a fault is triggered if the
following applies:

} For a positive software limit switch: actual position > limit switch position + I22

} For a negative software limit switch: actual position < limit switch position + I22

If the current position is on or beyond the limit switch, a fault can be triggered again when the
direction lock is no longer active (I196).
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6.4.2 Special cases
A few special cases are described below.

6.4.2.1 Behavior in jog mode

DANGER!

Risk of fatal injury due to gravity-loaded vertical axis!

If you select 0: Velocity control as the control type for jog mode, a gravity-loaded
vertical axis descends as soon as jog mode is activated via the control panel or
application (parameter I26).

▪ Only use the 0: Velocity control control type with axes that do not have a
gravity load.

The jog behavior depends on the control type selected for jog mode (I26).

I26 = 0: Velocity control:
As soon as the axis moves to a software limit switch, a quick stop is triggered instead of a fault. As a
result, the axis does not stop precisely on the software limit switch, but shortly thereafter depending
on the quick stop ramp. It can immediately be shut down again by the software limit switch. The
"incorrect" direction is locked.

I26 = 1: Position control:
The axis is braked during jog mode (with jog deceleration and jog jerk) in such a way that the axis
comes to a stop shortly before the software limit switch and does not overrun it.

6.4.2.2 Reaching the +/- 31 bit computing limit
Fault: 
53: Limit switch

Cause:
5: +/- 31 bit computing limit reached

The computing limit can be reached if, for example, so many commands follow after each other for
the moving axis that the total distance to be traveled (including decimal places) adds up to over 231.

6.4.2.3 Linear motor travel range
Fault: 
53: Limit switch

Cause:
6: Linear motor moving range

This fault is triggered if the axis is more than 200 m away from the commutation reference point,
which means that the actual position of the motor has left the permissible range (parameter: E09).
Check the axis model and correct the parameterization if necessary.
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6.4.2.4 Simultaneous detection of positive and negative hardware limit switches
Fault: 
53: Limit switch

Cause:
7: Both limit switches not connected

This fault is triggered if I441 and I442 are both 0: Inactive. Check whether the hardware limit switches
are also connected physically.

If I101 and I102 = 2: Parameter, the fault is triggered by the control word of the application (I210). In
this case, check the controller connection.

The fault can be acknowledged with I52.

6.4.2.5 Behavior upon controller start-up
Fault: 
53: Limit switch

Cause:
7: Both limit switches not connected

If a controller is used as the source for the digital signals for evaluating the hardware limit switches
and this is still in device start-up while the drive controller and fieldbus communication are already
active, fault 53: Limit switch is triggered and the limit switch memory is set (I805, I806 = 1: Active).

If the power unit has not yet been enabled since the supply voltage was switched on, the limit switch
memory is automatically reset as soon as the controller correctly transmits the signals for evaluating
the hardware limit switches.

6.5 Referencing
To be able to work with a system with absolute positions, the relation of a measured to an actual axis
position must be determined.

During initial commissioning or after changes to the axis model, the actual position of the axis is
unknown. A defined initial position is necessary.
As a rule, this is either identified through a reference search or referencing setting. The associated
process is referred to as referencing.
Absolute movements can be performed only in a referenced state.

When replacing a drive controller, the reference can be transferred to the replacement drive controller
via an SD card. The information is also saved on the SD card if the action A00 Save values is
executed for the referenced axis. For more information on replacing a drive controller, refer to the
manual for the respective drive controller.
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6.5.1 Referencing methods
The following table shows an overview of the possible referencing methods.

Abbreviation Meaning

S Switch

M/F Torque or force

Method Initial
movement

Zero
pulse

Feature

S  A Negative Yes Negative limit switch

B Negative Yes Negatively positioned reference
switch

C Negative – Negative limit switch

D Negative – Negatively positioned reference
switch

S E Positive Yes Positive limit switch

F Positive Yes Positively positioned reference
switch

G Positive – Positive limit switch

H Positive – Positively positioned reference
switch

S I Positive Yes Centrally positioned reference
switch

J Positive – Centrally positioned reference
switch

S K Negative Yes Centrally positioned reference
switch

L Negative – Centrally positioned reference
switch

M Negative Yes Zero pulse

N Positive Yes Zero pulse

O – – Setting the reference

M/F P Positive – Torque/force stop

Q Positive Yes Torque/force stop
M/F R Negative – Torque/force stop

S Negative Yes Torque/force stop

Tab. 4: Referencing methods
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6.5.1.1 Referencing methods in detail
The following chapters show the individual referencing methods in detail.

The following abbreviations are used in the graphs on the referencing methods:

Abbreviation Meaning

ALT Alternative

LS Limit Switch

RS Reference Switch

ZP Zero Pulse

Information

For graphically representing axes, the left is the smallest and the right is the largest
position value. This means a positive movement goes to the right and a negative to
the left.

The following parameters are used in the descriptions of the referencing methods:

Coordinate Name

I28 Homing torque/force limit

I29 Time homing torque/force limit

I30 Referencing type

I31 Referencing direction

I32 Referencing speed fast

I33 Referencing speed slow

I34 Reference position

I35 Referencing with zero pulse

I39 Referencing acceleration

I43 Move to reference position

I44 Referencing jerk

I53 Index search offset

I101 Source positive /limit switch

I102 Source negative /limit switch

I103 Source reference switch
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6.5.1.1.1 Referencing method A
Referencing method A determines a reference using a run to the negative limit switch and zero pulse.

LS+LS-

LS-

ZP

Preparation
1. Activate referencing method A by setting the following parameters to the specified values:

I30 to 2: Limit switch,
I31 to 1: Negative,
I35 to 1: Active.

2. I102: 
Enter the data source for the negative limit switch.

3. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

4. I53:
Define the start of the search for the zero pulse search

Referencing
If the PLCopen command MC_Home is active, referencing takes places as follows:

1. The drive starts in the negative direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the negative limit switch and continues its run with velocity
I33 until it reaches the next zero pulse after leaving the limit switch.

3. The current actual position is set to the value of reference position I34 upon reaching the zero
pulse.

4. The drive comes to a standstill with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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6.5.1.1.2 Referencing method B
Referencing method B determines the reference using a run to the negatively positioned reference
switch and zero pulse.

RS

ZP

ALT 2

ALT 1

RS

Preparation
1. Activate referencing method B by setting the following parameters to the specified values:

I30 to 1: Reference input,
I31 to 1: Negative,
I35 to 1: Active.

2. I103: 
Enter the data source for the reference switch.

3. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

4. I53:
Define the start of the search for the zero pulse search

Referencing
If the PLCopen command MC_Home is active, a distinction is made between two referencing
variants.

ü Alternative 1: Drive is positioned in front of the reference switch

1. The drive starts in the negative direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the reference switch and continues its run with velocity I33
until it reaches the next zero pulse after leaving the reference switch.

3. The current actual position is set to the value of reference position I34 upon reaching the zero
pulse.

4. The drive comes to a standstill with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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ü Alternative 2: Drive stopped at reference switch

1. The drive starts in the positive direction with acceleration I39 and velocity I33.

2. It changes its direction upon reaching the reference switch and continues its run with velocity
I32.

3. When the drive comes to a stop after the reference switch, it changes direction again and
continues at velocity I33 until it reaches the zero pulse.

4. The current actual position is set to the value of reference position I34 upon reaching the zero
pulse.

5. The drive comes to a standstill with deceleration I39.

6. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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6.5.1.1.3 Referencing method C
Referencing method C determines the reference using a run to the negative limit switch.

LS-

LS+LS-

Preparation
1. Activate referencing method C by setting the following parameters to the specified values:

I30 to 2: Limit switch,
I31 to 1: Negative,
I35 to 0: Inactive.

2. I102: 
Enter the data source for the negative limit switch.

3. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

Referencing
If the PLCopen command MC_Home is active, referencing takes places as follows:

1. The drive starts in the negative direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the negative limit switch and continues its run with velocity
I33 until it leaves the limit switch again.

3. The current actual position is set to the value of the reference position I34 upon leaving the limit
switch.

4. The drive comes to a standstill with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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6.5.1.1.4 Referencing method D
Referencing method D determines the reference using a run to the negatively positioned reference
switch.

RS

ALT 2

ALT 1

RS

Preparation
1. Activate referencing method D by setting the following parameters to the specified values:

I30 to 1: Reference input,
I31 to 1: Negative,
I35 to 0: Inactive.

2. I103: 
Enter the data source for the reference switch.

3. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

Referencing
If the PLCopen command MC_Home is active, a distinction is made between two referencing
variants.

ü Alternative 1: Drive is positioned in front of the reference switch

1. The drive starts in the negative direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the reference switch and continues its run with velocity I33
until it leaves the reference switch again.

3. The current actual position is set to the value of the reference position I34 upon leaving the
reference switch.

4. The drive comes to a standstill with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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ü Alternative 2: Drive stopped at reference switch

1. The drive starts with acceleration I39 and velocity I33 in the positive direction until it leaves the
reference switch.

2. It changes its direction upon leaving the reference switch and continues its run with velocity I32.

3. When the drive comes to a stop after the reference switch, it changes direction and continues its
run at velocity I33 until it reaches the reference switch again.

4. The current actual position is set to the value of the reference position I34 upon reaching the
reference switch.

5. The drive comes to a standstill with deceleration I39.

6. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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6.5.1.1.5 Referencing method E
Referencing method E determines the reference using a run to the positive limit switch and zero
pulse.

LS+

ZP

LS+LS-

Preparation
1. Activate referencing method E by setting the following parameters to the specified values:

I30 to 2: Limit switch,
I31 to 0: Positive,
I35 to 1: Active.

2. I101: 
Enter the data source for the positive limit switch.

3. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

4. I53:
Define the start of the search for the zero pulse search

Referencing
If the PLCopen command MC_Home is active, referencing takes places as follows:

1. The drive starts in the positive direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the positive limit switch and continues its run with velocity
I33 until it reaches the next zero pulse after leaving the limit switch.

3. The current actual position is set to the value of reference position I34 upon reaching the zero
pulse.

4. The drive comes to a standstill with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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6.5.1.1.6 Referencing method F
Referencing method F determines the reference using a run to the positively positioned reference
switch and zero pulse.

RS

ZP

ALT 2

ALT 1

RS

Preparation
1. Activate referencing method F by setting the following parameters to the specified values:

I30 to 1: Reference input,
I31 to 0: Positive,
I35 to 1: Active.

2. I103: 
Enter the data source for the reference switch.

3. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

4. I53:
Define the start of the search for the zero pulse search

Referencing
If the PLCopen command MC_Home is active, a distinction is made between two referencing
variants.

ü Alternative 1: Drive is positioned in front of the reference switch

1. The drive starts in the positive direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the reference switch and continues its run with velocity I33
until it reaches the next zero pulse after leaving the reference switch.

3. The current actual position is set to the value of reference position I34 upon reaching the zero
pulse.

4. The drive comes to a standstill with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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ü Alternative 2: Drive stopped at reference switch

1. The drive starts in the negative direction with acceleration I39 and velocity I33.

2. It changes its direction upon reaching the reference switch and continues its run with velocity
I32.

3. When the drive comes to a stop after the reference switch, it changes direction again and
continues at velocity I33 until it reaches the zero pulse.

4. The current actual position is set to the value of reference position I34 upon reaching the zero
pulse.

5. The drive comes to a standstill with deceleration I39.

6. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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6.5.1.1.7 Referencing method G
Referencing method G determines the reference using a run to the positive limit switch.

LS+

LS+LS-

Preparation
1. Activate referencing method G by setting the following parameters to the specified values:

I30 to 2: Limit switch,
I31 to 0: Positive,
I35 to 0: Inactive.

2. I101: 
Enter the data source for the positive limit switch.

3. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

Referencing
If the PLCopen command MC_Home is active, referencing takes places as follows:

1. The drive starts in the positive direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the positive limit switch and continues its run with velocity
I33 until it leaves the limit switch again.

3. The current actual position is set to the value of the reference position I34 upon leaving the limit
switch.

4. The drive comes to a standstill with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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6.5.1.1.8 Referencing method H
Referencing method H determines the reference using a run to the positively positioned reference
switch.

RS

RS

ALT 2

ALT 1

Preparation
1. Activate referencing method H by setting the following parameters to the specified values:

I30 to 1: Reference input,
I31 to 0: Positive,
I35 to 0: Inactive.

2. I103: 
Enter the data source for the reference switch.

3. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

Referencing
If the PLCopen command MC_Home is active, a distinction is made between two referencing
variants.

ü Alternative 1: Drive is positioned in front of the reference switch

1. The drive starts in the positive direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the reference switch and continues its run with velocity I33
until it leaves the reference switch again.

3. The current actual position is set to the value of the reference position I34 upon leaving the
reference switch.

4. The drive comes to a standstill with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.

ü Alternative 2: Drive stopped at reference switch

1. The drive starts with acceleration I39 and velocity I33 in the negative direction until it leaves the
reference switch.

2. It changes its direction upon leaving the reference switch and continues its run with velocity I32.

3. When the drive comes to a stop after the reference switch, it changes direction and continues its
run at velocity I33 until it reaches the reference switch again.

4. The current actual position is set to the value of the reference position I34 upon reaching the
reference switch.

5. The drive comes to a standstill with deceleration I39.

6. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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6.5.1.1.9 Referencing method I
Referencing method I determines the reference using a run to the centered reference switch and zero
pulse.

LS+LS- RS

RS

ZP

ALT 2

ALT 1

ALT 3

LS+

Preparation
1. Activate referencing method I by setting the following parameters to the specified values:

I30 to 1: Reference input,
I31 to 0: Positive,
I35 to 1: Active.

2. I103: 
Enter the data source for the reference switch.

3. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

4. I53:
Define the start of the search for the zero pulse search

Referencing
If the PLCopen command MC_Home is active, a distinction is made between three referencing
sequences.

ü Alternative 1: Drive is positioned between the negative limit and reference switches

1. The drive starts in the positive direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the reference switch and continues its run with velocity I33
until it reaches the next zero pulse after leaving the reference switch.

3. The current actual position is set to the value of reference position I34 upon reaching the zero
pulse.

4. The drive comes to a standstill with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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ü Alternative 2: Drive stopped at reference switch

1. The drive starts in the negative direction with acceleration I39 and velocity I33.

2. It changes its direction upon reaching the reference switch and continues its run with velocity
I32.

3. When the drive comes to a stop after the reference switch, it changes direction again and
continues at velocity I33 until it reaches the zero pulse.

4. The current actual position is set to the value of reference position I34 upon reaching the zero
pulse.

5. The drive comes to a standstill with deceleration I39.

6. If I43 is set to 1: Active, the drive is positioned at reference position I34.

ü Alternative 3: Drive is positioned between the reference and positive limit switches

1. The drive starts in the positive direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the positive limit switch until the reference switch is
reached.

3. Upon reaching the reference switch, the drive changes its velocity to I33 until it leaves the
reference switch again.

4. The current actual position is set to the value of the reference position I34 after leaving the
reference switch and upon reaching the next zero pulse.

5. The drive comes to a standstill with deceleration I39.

6. If I43 is set to 1: Active, the drive is positioned at reference position I34.



More on Drive Based Center Winder?

Manual Drive Based Center Winder – PMC SC6, PMC SI6
1006912-en-US-02

Pilz | 120

6.5.1.1.10 Referencing method J
Referencing method J determines the reference using a run to the centered reference switch.

LS+LS- RS

RS

ALT 2

ALT 1

ALT 3

LS+

Preparation
1. Activate referencing method J by setting the following parameters to the specified values:

I30 to 1: Reference input,
I31 to 0: Positive,
I35 to 0: Inactive.

2. I103: 
Enter the data source for the reference switch.

3. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

Referencing
If the PLCopen command MC_Home is active, a distinction is made between three referencing
sequences.

ü Alternative 1: Drive is positioned between the negative limit and reference switches

1. The drive starts in the positive direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the reference switch and continues its run with velocity I33
until it leaves the reference switch again.

3. The current actual position is set to the value of the reference position I34 upon leaving the
reference switch.

4. The drive comes to a standstill with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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ü Alternative 2: Drive stopped at reference switch

1. The drive starts in the negative direction with acceleration I39 and velocity I33.

2. It changes its direction upon reaching the reference switch and continues its run with velocity I32
until it leaves the reference switch.

3. When the drive comes to a stop after the reference switch, it changes direction and continues its
run at velocity I33 until it reaches the reference switch again.

4. The current actual position is set to the value of the reference position I34 upon reaching the
reference switch.

5. The drive comes to a standstill with deceleration I39.

6. If I43 is set to 1: Active, the drive is positioned at reference position I34.

ü Alternative 3: Drive is positioned between the reference and positive limit switches

1. The drive starts in the positive direction with acceleration I39 and velocity I32.

2. Upon reaching the positive limit switch, the drive changes its direction and continues its run until
it reaches the reference switch.

3. Upon reaching the reference switch, the drive changes its velocity to I33 until it leaves the
reference switch again.

4. The current actual position is set to the value of the reference position I34 upon leaving the
reference switch.

5. The drive comes to a standstill with deceleration I39.

6. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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6.5.1.1.11 Referencing method K
Referencing method K determines the reference using a run to the centered reference switch and
zero pulse.

ALT 2

ALT 1

ALT 3
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ALT 1

ALT 3

LS-

LS+LS- RS

Preparation
1. Activate referencing method K by setting the following parameters to the specified values:

I30 to 1: Reference input,
I31 to 1: Negative,
I35 to 1: Active.

2. I103: 
Enter the data source for the reference switch.

3. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

4. I53:
Define the start of the search for the zero pulse search

Referencing
If the PLCopen command MC_Home is active, a distinction is made between three referencing
variants.

ü Alternative 1: Drive is positioned between the reference and positive limit switches

1. The drive starts in the negative direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the reference switch and continues its run with velocity I33
until it reaches the next zero pulse after leaving the reference switch.

3. The current actual position is set to the value of reference position I34 upon reaching the zero
pulse.

4. The drive comes to a standstill with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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ü Alternative 2: Drive stopped at reference switch

1. The drive starts in the positive direction with acceleration I39 and velocity I33.

2. It changes its direction upon reaching the reference switch and continues its run with velocity
I32.

3. When the drive comes to a stop after the reference switch, it changes direction again and
continues at velocity I33 until it reaches the zero pulse.

4. The current actual position is set to the value of reference position I34 upon reaching the zero
pulse.

5. The drive comes to a standstill with deceleration I39.

6. If I43 is set to 1: Active, the drive is positioned at reference position I34.

ü Alternative 3: Drive is positioned between the negative limit and reference switches

1. The drive starts in the negative direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the negative limit switch and continues its run until the
reference switch is reached.

3. Upon reaching the reference switch, the drive changes its velocity to I33 and continues its run
until it reaches the next zero pulse after leaving the reference switch.

4. The current actual position is set to the value of reference position I34 upon reaching the zero
pulse.

5. The drive comes to a standstill with deceleration I39.

6. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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6.5.1.1.12 Referencing method L
Referencing method L determines the reference using a run to the centered reference switch.
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ALT 3
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Preparation
1. Activate referencing method L by setting the following parameters to the specified values:

I30 to 1: Reference input,
I31 to 1: Negative,
I35 to 0: Inactive.

2. I103: 
Enter the data source for the reference switch.

3. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

Referencing
If the PLCopen command MC_Home is active, a distinction is made between three referencing
variants.

ü Alternative 1: Drive is positioned between the reference and positive limit switches

1. The drive starts in the negative direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the reference switch and continues its run with velocity I33
until it leaves the reference switch again.

3. The current actual position is set to the value of the reference position I34 upon leaving the
reference switch.

4. The drive comes to a standstill with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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ü Alternative 2: Drive stopped at reference switch

1. The drive starts with acceleration I39 and velocity I33 in the positive direction until it leaves the
reference switch.

2. It changes its direction upon leaving the reference switch and continues its run with velocity I32.

3. When the drive comes to a stop after the reference switch, it changes direction and continues its
run at velocity I33 until it reaches the reference switch again.

4. The current actual position is set to the value of the reference position I34 upon reaching the
reference switch.

5. The drive comes to a standstill with deceleration I39.

6. If I43 is set to 1: Active, the drive is positioned at reference position I34.

ü Alternative 3: Drive is positioned between the negative limit and reference switches

1. The drive starts in the negative direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the negative limit switch and continues its run until the
reference switch is reached.

3. When the reference switch is reached, the drive changes its velocity to I33 and continues its run
until it leaves the reference switch again.

4. The current actual position is set to the value of the reference position I34 upon leaving the
reference switch.

5. The drive comes to a standstill with deceleration I39.

6. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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6.5.1.1.13 Referencing method M
This method determines the reference using a run to the zero pulse.

ZP

Preparation
1. Activate referencing method M by setting the following parameters to the specified values:

I30 to 3: Zero pulse,
I31 to 1: Negative,

2. I32, I39, I44, I34:
Define the set values necessary for the referencing.

Referencing
If the PLCopen command MC_Home is active, referencing takes places as follows:

1. The drive starts in the negative direction with acceleration I39 and velocity I32.

2. The current actual position is set to the value of reference position I34 upon reaching the zero
pulse.

3. The drive comes to a standstill with deceleration I39.

4. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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6.5.1.1.14 Referencing method N
Referencing method N determines the reference using a run to the zero pulse.

ZP

Preparation
1. Activate referencing method N by setting the following parameters to the specified values:

I30 to 3: Zero pulse,
I31 to 0: Positive,

2. I32, I39, I44, I34: 
Define the set values necessary for the referencing.

Referencing
If the PLCopen command MC_Home is active, referencing takes places as follows:

1. The drive starts in the positive direction with acceleration I39 and velocity I32.

2. The current actual position is set to the value of reference position I34 upon reaching the zero
pulse.

3. The drive comes to a standstill with deceleration I39.

4. If I43 is set to 1: Active, the drive is positioned at reference position I34.

6.5.1.1.15 Referencing method O
Referencing method O determines the reference by setting the reference to any position.

Preparation
1. I30: 

Activate referencing method O by setting this parameter to 5: Define home.

2. I34: 
Define the reference position.

Referencing
If the PLCopen command MC_Home is active, referencing takes places as follows:

The current actual position is set to the value of the reference position I34.
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6.5.1.1.16 Referencing method P
Referencing method P determines the reference using a run with a torque/force stop.

Preparation
1. Activate referencing method P by setting the following parameters to the specified values:

I30 to 4: Torque/force stopper,
I31 to 0: Positive,
I35 to 0: Inactive.

2. I32, I39, I44, I34: 
Define the set values necessary for the referencing.

3. I28, I29: 
Define the torque/force limit. If the actual torque for the time stored in I29 is above the limit
defined in I28 for an ongoing period, the torque/force limit is reached.

Information

In case of a selected value for the torque/force variable that is too big, the machine
can be damaged. In case of a selected value that is too small, an incorrect reference
position may be applied.

Referencing
If the PLCopen command MC_Home is active, referencing takes places as follows:

1. The drive starts in the positive direction with acceleration I39 and velocity I32.

2. The current actual position is set to the value of the reference position I34 when the torque/force
limit is reached and the time stored in I29 has elapsed.

3. The set values are set to the value 0 with deceleration I39.

4. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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6.5.1.1.17 Referencing method Q
Referencing method Q determines the reference using a run with a torque/force stop and zero pulse.

ZP

Preparation
1. Activate referencing method Q by setting the following parameters to the specified values:

I30 to 4: Torque/force stopper,
I31 to 0: Positive,
I35 to 1: Active.

2. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

3. I28, I29: 
Define the torque/force limit. If the actual torque for the time stored in I29 is above the limit
defined in I28 for an ongoing period, the torque/force limit is reached.

4. I53:
Define the start of the search for the zero pulse search.

Information

In case of a selected value for the torque/force variable that is too big, the machine
can be damaged. In case of a selected value that is too small, an incorrect reference
position may be applied.

Referencing
If the PLCopen command MC_Home is active, referencing takes places as follows:

1. The drive starts in the positive direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the torque/force stop and when the time stored in I29 has
passed, and continues its run with velocity I33 until it reaches the next zero pulse.

3. The current actual position is set to the value of reference position I34 upon reaching the zero
pulse.

4. The set values are set to the value 0 with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.



More on Drive Based Center Winder?

Manual Drive Based Center Winder – PMC SC6, PMC SI6
1006912-en-US-02

Pilz | 130

6.5.1.1.18 Referencing method R
Referencing method R determines the reference using a run with a torque/force stop.

Preparation
1. Activate referencing method R by setting the following parameters to the specified values:

I30 to 4: Torque/force stopper,
I31 to 1: Negative,
I35 to 0: Inactive.

2. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

3. I28, I29: 
Define the torque/force limit. If the actual torque for the time stored in I29 is above the limit
defined in I28 for an ongoing period, the torque/force limit is reached.

Information

In case of a selected value for the torque/force variable that is too big, the machine
can be damaged. In case of a selected value that is too small, an incorrect reference
position may be applied.

Referencing
1. The drive starts in the negative direction with acceleration I39 and velocity I32.

2. The current actual position is set to the value of the reference position I34 when the torque/force
stop is reached and the time stored in I29 has elapsed.

3. The set values are set to the value 0 with deceleration I39.

4. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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6.5.1.1.19 Referencing method S
Referencing method S determines the reference using a run with torque/force stop and zero pulse.

ZP

Preparation
1. Activate referencing method S by setting the following parameters to the specified values:

I30 to 4: Torque/force stopper,
I31 to 1: Negative,
I35 to 1: Active.

2. I32, I33, I39, I44, I34: 
Define the set values necessary for referencing.

3. I28, I29: 
Define the torque/force limit. If the actual torque for the time stored in I29 is above the limit
defined in I28 for an ongoing period, the torque/force limit is reached.

4. I53:
Define the start of the search for the zero pulse search

Information

In case of a selected value for the torque/force variable that is too big, the machine
can be damaged. In case of a selected value that is too small, an incorrect reference
position may be applied.

Referencing
If the PLCopen command MC_Home is active, referencing takes places as follows:

1. The drive starts in the negative direction with acceleration I39 and velocity I32.

2. It changes its direction upon reaching the torque/force stop and after the time stored in I29 has
passed, and continues its run with velocity I33 until it reaches the next zero pulse.

3. The current actual position is set to the value of reference position I34 upon reaching the zero
pulse.

4. The set values are set to the value 0 with deceleration I39.

5. If I43 is set to 1: Active, the drive is positioned at reference position I34.
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6.5.2 Reference position
Depending on the referencing type I30, the actual position I80 is replaced by the reference position
I34 during the referencing event.

6.5.3 Reference retaining
Pilz offers a convenient drive-based referencing system. Depending on the encoder model used and
the reference management, different types of reference retaining (I46) are offered.
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6.6 Drive Based device control
Drive Based device control is based on DRIVECOM profile drive technology 21; this profile describes
the control sequence of a drive controller based on a device state machine. Each device state here
represents a certain behavior that can be changed only through defined events. These events are
assigned to individual state transitions.

For example, device control regulates the device start-up when turning on the supply voltage, the
enable state of the drive controller, the process of a quick stop, the behavior in case of fault and the
restart after a fault.

Some of the conditions and responses coupled with the state transitions can be influenced specific to
the user. For example, it is possible to define the end of a quick stop or enable delays in a way that is
tailored to the respective application case (see wizard Drive Based device control).

The following chapters describe the device states and the possible state transitions associated with
them. You will also learn whether certain actions are necessary on your part to reach the individual
device states, what those actions are and which user-specific factors you can parameterize yourself.
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6.6.1 Drive Based device state machine
The device state machine describes the different device states of the drive controller along with the
possible state changes.

Not ready to switch on

Switch on disabled

Ready to switch on

Switched on

Operation enabled

Fault reaction active

Faults

Quick stop active

0

16

1

2 6

53

4

10
12
13

11

7

15

14

8

9

Fig. 31: Drive Based device state machine: device states and state changes

6.6.2 States, transitions and conditions
The states provided by Drive Based device control all have specific features. A state either transitions
into another state automatically or requires certain actions from the user. There are also transition
conditions that you can parameterize to be tailored to your application case using the Drive Based
device control wizard.

Parameter E48 shows the current device state of a drive controller.

6.6.2.1 Not ready to switch on

Features
} The drive is being initialized, tested and associated parameters are being loaded

} The power unit as well as drive and activation functions are locked

} Brakes remain engaged

Transition to Switch on disabled (1)
The drive controller switches to Switch on disabled (1) automatically after successfully completing the
self-test.
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6.6.2.2 Switch on disabled

Features
} Initialization has been completed

} Self-test was successfully completed

} The power unit as well as drive and activation functions are locked

} Brakes remain engaged, release override can be requested with a rising edge

Possible causes of a switch-on lockout include:

1. Insufficient or no supply voltage or deactivated DC link supply

2. STO safety function is active

3. Release override is active

Transition to Ready to switch on (2)
The exact cause of a switch-on lockout can be found in parameters E47 and E49.

The transition to Ready to switch on happens automatically upon remedying the relevant cause of the
switch-on lockout.

Application-specific parameterization
A34 Auto start:

If this parameter is activated, the drive controller switches directly to the state Operation enabled if an
enable signal is present.

WARNING!

Injury to persons and material damage due to unexpected motor startup!

Only activate autostart if the standards and regulations applicable to the system or
machine in question permit a direct switch to the Operation enabled device state.

▪ In accordance with EN 61800-5-1, clearly mark an activated autostart on the
system and in the associated system documentation.

6.6.2.3 Ready to switch on

Features
} Power unit and drive function are disabled

} Drive controller is ready to switch on

} Brakes remain engaged, release override can be requested with a rising edge

Transitions to Switched on (3) or Switch on disabled (6)
Activate the enable signal (3) or one of the possible causes of a switch-on lockout is present (6).
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Application-specific parameterization
In addition to the enable signal at terminal X1, the Drive Based device state machine also supports
the use of an additional enable signal, for example over a fieldbus or using digital inputs. The enable
signal and additional enable signals are coupled by an AND link. In this case, the drive controller is
enabled only if the value of both signals is HIGH.

A60 Source additional enable:

If you are working with an additional enable signal, define the data source of the additional signal in
this parameter. In the case of a fieldbus connection, A180 bit 0 supplies the additional enable signal.

6.6.2.4 Switched on

Features
} Power unit is ready for operation

} Drive function is locked; set values are not processed

} Brakes remain engaged, release override can be requested with a rising edge

Transition to Operation enabled (4), Ready to switch on (5) or Switch on disabled (13)
Leave the enable signal active (4) or deactivate it (5). If one of the possible causes of a switch-on
lockout is present, the drive controller automatically switches to Switch on disabled (13).

6.6.2.5 Operation enabled

Features
} Power unit is switched on

} Drive function is enabled, set values are processed

Transitions to Quick stop active (7), Ready to switch on (11) or Switch on disabled
(12)
Request a quick stop (7) or deactivate the enable signal (11). If one of the possible causes of switch-
on lockout is present, the drive controller automatically switches to Switch on disabled (12).

Application-specific parameterization
} A43 Switch-off delay X1 enable:

If the enable signal at terminal X1 of a safety relay is affected by OSSD test pulses, the drive
controller cannot differentiate these signals from a functional enable-off. An incorrect interpretation
of the test pulses can be avoided by defining a delay time in this parameter that is greater than the
duration of the test pulses. This then eliminates unexpected switching of the drive controller to the
states Ready to switch on or Quick stop active (see parameter A44).

} A44 Quick stop at enable off:
This parameter results in a drive being stopped with a quick stop in case of an inactive enable. In
this case, the drive controller switches to the state quick stop active. If parameter A44 is not
activated, the drive switches to the Ready to switch on state in case of Enable-off.
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6.6.2.6 Quick stop active

Features
} Power unit is switched on; drive function is enabled

} A quick stop is executed

} Brakes remain released, brake engages at the end of the quick stop or at standstill

} Brake engaging ends the quick stop

Transition to Operation enabled (8), Ready to switch on (9) or Switch on disabled (10)
Cancel the quick stop request (8). If the quick stop was carried out fully while the enable signal is
inactive, the drive controller automatically switches to Ready to switch on (9); if one of the possible
causes of a switch-on lockout is present, the drive controller automatically switches to Switch on
disabled (10).

Application-specific parameterization
} A39 Maximum quick stop duration for enable off:

If the drive is stopped with a quick stop in the case of an inactive enable signal (see A44), define
the maximum time after which the power unit is switched off in this parameter.

} A45 Quick stop end:
Define whether a quick stop is ended with a standstill of the drive or by canceling the quick stop
request in this parameter.

} A62 Source /quick stop:
Define how a requested quick stop is triggered in this parameter.

6.6.2.7 Fault reaction active

Features
} A drive error has occurred

} Fault reaction is executed depending on the respective fault event

} Brakes are activated depending on the respective fault reaction

Transition to fault (15)
After completed fault response, the drive controller switches to Fault (15) automatically.

Application-specific parameterization
A29 Quick stop in case of fault:

If this parameter is activated, the drive is stopped with a quick stop, if possible, in case of fault; if the
parameter is inactive, the movement of the axis is no longer controlled by the drive controller.
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6.6.2.8 Fault

Features
} A drive error has occurred

} The fault reaction is finished

} The power unit as well as drive and activation functions are locked

} Brakes engage

Transition to Switch on disabled (16)
After remedying the fault cause and then acknowledging the fault message, the drive controller
automatically switches to Switch on disabled (16).
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6.7 Motion commands
The operating modes of the application feature special motion commands that are based on the
PLCopen standard and are supplemented by three manufacturer-specific motion commands
(MC_DoNothing, MC_MoveSpeed and MC_Winder). Any motion command – except MC_Stop – can
be interrupted during execution. To be able to execute a motion command, the following requirements
must be met:

} Local and jog mode must not be activated

} A drive controller must not be in the Switch on disabled or Fault device state

Command Description Control type Necessary motion
variables

0: MC_DoNothing — — —

8: MC_MoveSpeed Axis moves without
end with set velocity
(without position
control)

Velocity } Velocity, override

} Acceleration

} Deceleration

} Jerk

4: MC_MoveVelocity Axis moves without
end with set velocity
(with position control)

Position } Velocity, override

} Acceleration

} Deceleration

} Jerk

9: MC_TorqueControl Axis moves without
end with set torque/
force

Torque/force } Torque/force

2: MC_MoveRelative Axis moves a relative
distance;
set position is relative
to the actual position at
the start of the
command

Position } Position

} Velocity, override

} Acceleration

} Deceleration

} Jerk

3: MC_MoveAdditive Axis moves a relative
distance;
set position is relative
to the set position of
the previous motion
command

Position } Position

} Velocity, override

} Acceleration

} Deceleration

} Jerk

1: MC_MoveAbsolute Axis moves to an
absolute set position
(referencing
necessary)

Position } Position

} Velocity, override

} Acceleration

} Deceleration

} Jerk
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Command Description Control type Necessary motion
variables

6: MC_Home Axis is referenced Depending on the
selected referencing
type

} Velocity, override

} Acceleration

} Deceleration

} Jerk

} Torque/force

11: MC_Halt Axis is stopped;
next command can be
run before standstill

Velocity } Deceleration

} Jerk

5: MC_Stop Axis is brought to a
standstill;
next command can be
executed after
standstill

Velocity } Deceleration

} Jerk

30: MC_Winder Axis moves according
to the control behavior
of the center winder
(L00)

Velocity } Material velocity

} Material tensile force

} Acceleration

} Deceleration

} Jerk

Tab. 5: Drive Based Center Winder: Available motion commands

For detailed information on the motion commands, refer to the associated manual (see Further
information [ 146]).
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6.8 Continue function
In Drive Based Center Winder type applications, the continue function allows you to resume
interrupted motion commands, for example after a quick stop, the triggering of safety technology or
after an event with a fault reaction. Using the continue function, you can also continue motion
commands 2: MC_MoveRelative and 3: MC_MoveAdditive and end with the desired set position,
which would not be possible when restarting using the execute signal.

Cancellation causes that can be continued
} Event with fault reaction

} Enable-off

} Motion command 5: MC_Stop, 11: MC_Halt

} Stop signal

} Quick stop signal

} SS1, SS2

} Jog

Motion commands

Motion command
(I401)

Continue Note

0: MC_DoNothing – –

1: MC_MoveAbsolute ✓ Motion continues until the set position is
reached; set position is absolute

2: MC_MoveRelative ✓ Motion continues until the set position is
reached; set position is relative to actual position
at the start of the command

3: MC_MoveAdditive ✓ Motion continues until the set position is
reached; set position is relative to the set
position of the previous motion command

4: MC_MoveVelocity ✓ Motion continues without end at set velocity

5: MC_Stop – –

6: MC_Home – –

8: MC_MoveSpeed ✓ Motion continues without end at set velocity

9: MC_TorqueControl ✓ Motion continues without end with set torque/
force

11: MC_Halt – –
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6.9 Electronic nameplate
Pilz synchronous servo motors are generally equipped with EnDat encoders that provide a special
memory. This memory includes the electronic nameplate, i.e. all type-relevant master data as well as
special mechanical and electronic values of a motor.

When you operate a drive controller with a Pilz synchronous servo motor and an EnDat encoder, the
electronic nameplate is read and all data transferred if the drive controller is connected online. This
specifically includes job data, current controller values, motor parameters, data on motor temperature
sensors, brakes, the commutation offset and the measured electromotive force. These can be
manually optimized later and resaved in the drive controller.

Every time a drive controller is restarted, it checks whether the projected motor, the brake (if
applicable), the motor temperature sensor or commutation have been changed. If so, the changed
data is read out. The optimizations saved in the drive controller are maintained whenever possible.

The automatic read-out of the electronic nameplate is activated at the factory (B04 Electronic
nameplate = 64: Active).

6.10 Lag monitoring
In Drive Based Center Winder type applications, you can monitor the lag of the axis with active
position control in order to detect increasing position deviations at an early stage. Monitoring the lag
allows you to react quickly before material damage can occur, e.g. in the event of stiffness or a
mechanical blockage of the output.

To monitor the lag, the difference between the actual position of the axis and the set position x2set of
the control is determined and compared with the maximum permissible lag (actual position: I80; set
position: I96; permissible lag: I21; result: I187). If the permitted lag is exceeded, event 54: Following
error is triggered with the corresponding protection level (protection level: U22).
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7 Appendix

7.1 Standard mapping of Drive Based Center Winder

Information

For fieldbus communication via PROFINET, the processing of process data in some
controllers is WORD-oriented (16 bits). In Drive Based applications, the standard
mapping is pre-assigned appropriately. If changes are made to the standard
mapping, take the parameter data type that you are adding to or removing from the
mapping into account.

If you add or remove parameters of the BYTE or INT8 data type (8 bit), this can
cause problems in the data structures of the controller. If necessary, use parameter
A101 Dummy byte to fill the 8-bit gaps that result in the process data and implement
the necessary data structure for the controller.
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7.1.1 PMC SC6, PMC SI6: Drive Based Center Winder receive process data
The following table shows the standard mapping for the receive process data in the Drive Based
Center Winder application. For fieldbus communication via PROFINET, the process data mapping for
axis A is done via parameter A90 and for axis B via A91. For fieldbus communication via EtherCAT,
the process data mapping for axis A is done via parameter A225 and for axis B via A226. If
necessary, the standard mapping can be customized.

Byte Data type Name Parameter

0 BYTE Device control byte 1.A180

1 BYTE Control byte command 1.J37

2 – 3 WORD Control word application 1.I210

4 INT8 Command 1.J40

5 INT8 Motion-ID 1.J41

6 – 9 INT32 Position 1.J42

10 – 13 REAL32 Velocity 1 1.J43

14 – 17 REAL32 Velocity Override 1.J56

18 – 21 REAL32 Torque/Force reference 1.G469

22 – 23 WORD Control word center winder 1.L150

24 – 27 REAL32 Diameter sensor actual value 1.L25

28 – 31 REAL32 Set material velocity 1.L405

32 – 35 REAL32 Actual material velocity 1.L650

36 – 39 REAL32 Set material tensile force 1.L496

Tab. 6: PMC SC6, PMC SI6: receive process data (standard mapping); first part, axis A

Byte Data type Name Parameter

0 BYTE Device control byte 2.A180

1 BYTE Control byte command 2.J37

2 – 3 WORD Control word application 2.I210

4 INT8 Command 2.J40

5 INT8 Motion-ID 2.J41

6 – 9 INT32 Position 2.J42

10 – 13 REAL32 Velocity 1 2.J43

14 – 17 REAL32 Velocity Override 2.J56

18 – 21 REAL32 Torque/Force reference 2.G469

22 – 23 WORD Control word center winder 2.L150

24 – 27 REAL32 Diameter sensor actual value 2.L25

28 – 31 REAL32 Set material velocity 2.L405

32 – 35 REAL32 Actual material velocity 2.L650

36 – 39 REAL32 Set material tensile force 2.L496

Tab. 7: PMC SC6, PMC SI6: receive process data (standard mapping); second part, axis B



Appendix

Manual Drive Based Center Winder – PMC SC6, PMC SI6
1006912-en-US-02

Pilz | 145

7.1.2 PMC SC6, PMC SI6: Drive Based Center Winder transmit process data
The following table shows the standard mapping for the transmit process data in the Drive Based
Center Winder application. For fieldbus communication via PROFINET, the process data mapping for
axis A is done via parameter A94 and for axis B via A95. For fieldbus communication via EtherCAT,
the process data mapping for axis A is done via parameter A233 and for axis B via A234. If
necessary, the standard mapping can be customized.

Byte Data type Name Parameter

0 BYTE Status byte device 1.E200[0]

1 BYTE Status byte device 1.E200[1]

2 – 3 WORD Status word 2 1.E201

4 BYTE Status byte application 1.I212

5 BYTE Status byte command 1.J39

6 – 7 WORD Status word application 1.I200

8 – 11 INT32 Current position 1.I80

12 – 15 REAL32 Actual speed 1.I88

16 – 19 REAL32 Actual torque/force 1.E90

20 – 21 WORD Status word user-defined 1.A67

22 INT8 Operating condition 1.E80

23 INT8 Device control state 1.E48

24 – 25 WORD Status word center winder 1.L155

26 – 29 REAL32 Diameter filtered 1.L29

Tab. 8: PMC SC6, PMC SI6: transmit process data (standard mapping); first part, axis A

Byte Data type Name Parameter

0 BYTE Status byte device 2.E200[0]

1 BYTE Status byte device 2.E200[1]

2 – 3 WORD Status word 2 2.E201

4 BYTE Status byte application 2.I212

5 BYTE Status byte command 2.J39

6 – 7 WORD Status word application 2.I200

8 – 11 INT32 Current position 2.I80

12 – 15 REAL32 Actual speed 2.I88

16 – 19 REAL32 Actual torque/force 2.E90

20 – 21 WORD Status word user-defined 2.A67

22 INT8 Operating condition 2.E80

23 INT8 Device control state 2.E48

24 – 25 WORD Status word center winder 2.L155

26 – 29 REAL32 Diameter filtered 2.L29

Tab. 9: PMC SC6, PMC SI6: transmit process data (standard mapping); second part, axis B



Appendix

Manual Drive Based Center Winder – PMC SC6, PMC SI6
1006912-en-US-02

Pilz | 146

7.2 Further information
The documentation listed below provides you with further relevant information on the drive controllers.
The current status of the documentation can be found at:
https://www.pilz.com/en-INT.

Title Documentation Contents ID

PMC SC6 drive controller Manual System design, technical data,
project configuration, storage,
installation, connection,
commissioning, operation, service,
diagnostics

1005343

Multi-axis drive system with
PMC SI6 and PMC PS6

Manual System design, technical data,
project configuration, storage,
installation, connection,
commissioning, operation, service,
diagnostics

1005342

PROFINET communication
– PMC SC6, PMC SI6

Manual Electrical installation, data transfer,
commissioning, diagnostics, detailed
information

1006907

EtherCAT communication –
PMC SC6, PMC SI6

Manual Electrical installation, data transfer,
commissioning, diagnostics, detailed
information

1005346

PMC SR6 safety technology
– STO via terminals

Manual Technical data, installation,
commissioning, diagnostics, detailed
information

1005344

PMC SU6 safety technology
– STO and SS1 via
PROFIsafe

Manual Technical data, installation,
commissioning, diagnostics, detailed
information

1006910

PMC SY6 safety technology
– STO and SS1 via FSoE

Manual Technical data, installation,
commissioning, diagnostics, detailed
information

1005345

Motion commands Manual Control and status information,
denials and limitations, motion

1006913

https://www.pilz.com/en-INT
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7.3 Formula symbols

Symbol Unit Explanation

F N Force

M Nm Torque

M1 Nm Torque at the gear unit input

M2 Nm Torque at the gear unit output

MRdyn Nm/1000 rpm Dynamic frictional torque of the axis

MRstat Nm Static frictional torque of the axis

n rpm Speed

n1 rpm Speed at gear unit input

n2 rpm Speed at the gear unit output
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7.4 Abbreviations

Abbreviation Meaning

AI Analog Input

ALT Alternative

CAN Controller Area Network

CB Controller Based

CiA CAN in Automation

CNC Computerized Numerical Control

DI Digital Input

EtherCAT Ethernet for Control Automation Technology

IGB Integrated Bus

LS Limit Switch

LSB Least Significant Bit

M Motor

M/F Torque or force

MEnc Motor Encoder

PEnc Position Encoder

PROFINET Process Field Network

RS Reference Switch

S Switch

PLC Programmable Logic Controller

ZP Zero Pulse
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Glossary

Actual material tensile force
Actual tensile force with which the material is wound
onto or unwound from a winder case in the winding
process.

Actual material velocity
Actual velocity at which the material is wound onto
or unwound from a winder case in the winding
process.

Broadcast domain
Logical grouping of network devices within a local
network that reaches all nodes via broadcast.

Center winder
System that makes it possible to wind or unwind
materials and in which the winder is driven by a
shaft located in the center of the winder.

Control cascade
Complete model of the control structure with the
position controller, velocity controller and current
controller components.

Electronic nameplate
The synchronous servo motors are generally
equipped with absolute encoders that provide
special memory. This memory includes the
electronic nameplate, i.e. all type-relevant master
data as well as special mechanical and electronic
values of a motor. When you operate a drive
controller with a synchronous servo motor and an
absolute encoder, the electronic nameplate is read
and all motor data transferred if the drive controller
is connected online. The drive controller
automatically determines the associated limit values
and control parameters from this data.

Frictional torque
Torque that arises if friction forces act on a rotating
body and restrict its rotation.

i²t model
Computational model for thermal monitoring.

IPv4 limited broadcast
Type of broadcast in a network with IPv4 (Internet
Protocol version 4). The IP address
255.255.255.255 is entered as the destination. The
content of the broadcast is not forwarded by a
router, which limits it to the local network.

Mass moment of inertia
Indicates the resistance of a rigid body to a change
in its rotational movement about a given axis (torque
divided by angular acceleration).

Material tensile force
Tensile force with which the material is wound onto
or unwound from a winder case in the winding
process.

Material velocity
Velocity at which the material is wound onto or
unwound from a winder case in the winding process.

PID controller
Universal controller type with a P-, I- and D-share.
These three adjustment parameters make the
controller flexible and ensure exact and highly
dynamic control. However, by implication, it also
necessitates a wide variety of variants. It is that
much more important to ensure careful construction
that is well-coordinated to the system. The
application areas for this controller type are control
circuits with systems of the second order and higher,
which must be stabilized quickly and do not allow for
any permanent control deviation.

PROFINET
Open Ethernet standard of PROFIBUS
Nutzerorganisation e. V. (PNO) for automation.

Set material tensile force
Target tensile force with which the material is to be
wound onto or unwound from a winder case in the
winding process.

Set material velocity
Target velocity at which the material is to be wound
onto or unwound from a winder case in the winding
process.

Winder
A system that allows winding or unwinding of
materials.

Winder case
Case that serves as a carrier for the material in the
winding process and onto which material is wound
or from which material is unwound.

Winding
Unit consisting of a winder case and the material on
it.

Winding diameter
Diameter of a winding.

Winding method
Method with which a material is wound onto or
unwound from a winder case.
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+90 216 5775552
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